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Introduction to the Precipitation Module (TC-
PRISMA)
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About the Precipitation Module (TC-PRISMA)

The Precipitation Module, or TC-PRISMA, is an Add-on Module to Thermo-Calc and it is 
available in Graphical Mode as the Precipitation Calculator.

The Module treats concurrent nucleation, growth/dissolution and coarsening under arbitrary 
heat treatment conditions in multi-component and multi-phase systems using Langer-Schwartz 
theory and the Kampmann-Wagner numerical approach. It is a general computational tool for 
simulating kinetics of diffusion controlled multi-particle precipitation processes in 
multicomponent and multiphase alloy systems.

You can use the Precipitation Module for:

 l Concurrent nucleation, growth/dissolution and coarsening of precipitates

 l Normal grain growth and Zener pinning

 l Temporal evolution of particle size distribution

 l Average particle radius and number density

 l Volume fraction and composition of precipitate

 l Nucleation rate and coarsening rate

 l Time-Temperature-Precipitation (TTP) diagrams

 l Continuous-Cooling-Transformation (CCT) diagrams

 l Estimation of multi-component interfacial energy

 l Estimation  of yield stress using the Yield Strength Property Model

The configuration of the Yield Strength Property Model is completed on the 
Property Model Calculator and then accessed as a variable with the Plot Renderer 
or Table Renderer.

In order to perform a simulation in the Precipitation Module, both a thermodynamic database 
and a kinetic database is needed. The thermodynamic database is a normal Thermo-Calc 
database, whereas the kinetic database contains information about the atomic mobility of 
individual elements in various phases.
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Precipitation, formation of particles of a second phase, or second phases from a supersaturated 
solid solution matrix phase, is a solid state phase transformation process that has been 
exploited to improve the strength and toughness of various structural alloys for many years. 
This process is thermochemically driven and fully governed by system (bulk and interface) 
thermodynamics and kinetics.

Typically, a precipitation process has three distinctive stages: nucleation, growth, and 
coarsening. However, under certain conditions, these can also happen at the same time. With 
the Precipitation Module, the kinetics of concurrent nucleation, growth, and coarsening can be 
simulated by calculating the evolution of the probability distribution of the particle number 
densities, usually called particle size distribution (PSD). The simulation results can be used to 
understand and guide how to obtain desirable precipitates with certain PSD or to avoid 
undesirable precipitations during heat treatments of alloys such as aging and tempering.

A summary for the input and output of the Precipitation Module is shown.

Input and Output of the Precipitation Module

The Precipitation Module relies on CALPHAD-based software tools and databases to provide the 
necessary bulk thermodynamic and kinetic data for phases in multicomponent systems. The 
CALPHAD approach has been developed for more than 50 years and is routinely applied to 
design new alloys and optimize existing materials within various metal industries, such as steels 
and alloys of nickel, titanium, aluminum and magnesium.

The power of this approach is due to the adopted methodology where free energy and atomic 
mobility of each phase in a multicomponent system can be modeled hierarchically from lower 
order systems, and model parameters are evaluated in a consistent way by considering both 
experimental data and ab-initio calculation results. The Precipitation Module is directly 
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integrated into Thermo-Calc, a CALPHAD-based computer program for calculating phase 
equilibrium. Another Add-on Module, the Diffusion Module (DICTRA) is available for diffusion 
controlled phase transformation in multicomponent systems.

With Thermo-Calc and the accompanying thermodynamic and mobility databases, almost all 
fundamental phase equilibrium and phase transformation information can be calculated 
without unnecessary and inaccurate approximations. For example you can calculate:

 l Driving forces for nucleation and growth

 l Operating tie-lines under local equilibrium conditions

 l Deviations from local equilibrium at interfaces due to interface friction

 l Atomic mobilities or diffusivities in the matrix phase

In addition to bulk thermodynamic and kinetic data, a few other physical properties, such as 
interfacial energy and volume, are needed in precipitation models. These additional physical 
parameters can be obtained by experiments or other estimation models or first principles 
calculations. Volume data are available in most of our thermodynamic databases . The 
Precipitation Module has an estimation model available for interfacial energy.

This guide is a supplement to the full Thermo-Calc documentation set. It is 
recommended that you use the Online Help, which you can access in Thermo-Calc 
by pressing F1 or from the main menu choose Help → Online help.

See "Help Resources" on page 13 to learn how to access this information if you 
have not already done so.
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Available Options

The Precipitation Module, previously referred to as TC-PRISMA, is an Add-on Module to the 
core Thermo-Calc software. 

A separate license is required to perform calculations for more than three 
elements. Without it you are able to use the module in Demo Mode. 

Precipitation Template

A Precipitation template under Non-Equilibrium Calculations is available to all Thermo-Calc 
users when in Graphical Mode. If you are in DEMO mode then  this is indicated by the addition 
of DEMO text.

Using the Template

After opening Thermo-Calc in Graphical Mode,  in the templates section under Non-Equilibrium, 
click the Precipitation button to add a System Definer, Precipitation Calculator, and Plot 
Renderer to the Project tree.

Precipitation Calculator

A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation 
calculation. 
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Demo Database Packages for the Examples Collection

Both a thermodynamic and mobility database are required to run the Precipitation Module 
simulation.   If you have a Precipitation Module (TC-PRISMA) license you can run all the examples 
as the demonstration database packages are included with your installation. Select the 
database packages from the System Definer → Configuration window to run a simulation. 

Demonstration (Demo) Mode

The Precipitation Module, and some examples, are available to all Thermo-Calc users but only 
for simulations of alloys with up to three elements. If you do not have a license for the 
Precipitation Module then you are in Demonstration Mode when using the Precipitation 
Calculator or Precipitation Simulation template. 

A Precipitation template under Non-Equilibrium Calculations is available to all Thermo-Calc 
users when in Graphical Mode. If you are in DEMO mode then  this is indicated by the addition 
of DEMO text.

Precipitation Calculator

If you are experimenting with the Precipitation Calculator in Demo Mode, you may have access 
to a variety of databases based on your license. However, you can only define up to three 
elements for a demo simulation. 

If you define more than three elements on the System Definer, when you go to the 
Precipitation Calculator, the Perform button is unavailable and the tooltip explains why. In this 
case one of the chosen elements needs to be removed and then the Perform button is made 
available.
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Even if you have more than three elements, the Plot Renderer or Table Renderer 
Perform button is still available. However, if you click the button and try to run the 
simulation the Event Log displays an error message.

Additive Manufacturing (AM) Module

There is connectivity between the Diffusion Module (DICTRA) or the  Precipitation Module (TC-
PRISMA) and the Additive Manufacturing (AM) Module when you have full licenses available for 
all relevant Add-on Modules and databases. 

You can add a Diffusion Calculator or Precipitation Calculator as a successor to the 
AM Calculator and then when probes are included with the AM Calculator this data can be 
further used with the thermal profile. 
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Network License Restrictions

The Precipitation Module (TC-PRISMA) requires a separate license. If you are using a network 
client installation of Thermo-Calc, then you may not be able to use it even if you have access to 
a license server with a valid network license file. The reason for this is because other clients 
who are part of your network installation may have checked out all instances of the network 
license allowed to run simultaneously. 

For users with a network license, you must exit Thermo-Calc to release the license 
for other users. The license is checked out as soon as you add a Precipitation 
Calculator and remains unavailable to other users until you exit the program. 

With a network license, and if as per above you temporarily do not have access to a 
license, you are automatically put into Demo Mode. Then the Precipitation 
Calculator is available with three elements. 

Search the online help or see the Thermo-Calc Installation Guide for more about 
network licenses.
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Help Resources

'Online' Help: No Internet Required

There are several ways to access online help in a browser. The content opens in a browser but 
uses local content so you do not need an Internet connection except for links to external 
websites.

First open Thermo-Calc, then choose one of these options:

 l Press <F1> on the keyboard.

 l Select Help →  Online Help.

 l On the My Project Configuration window, click  Online Help.

 l At the bottom of any Configuration window, click  Help.

There are several resources available on our website to help you learn how to use 
Thermo-Calc and other Add-on Modules. Go to the Getting Started Guides page 
and choose one of the guides that provides new users an introduction to setting 
up simple calculations in Graphical Mode. The information there is also in this help 
documentation.

https://thermocalc.com/support/getting-started-guides/
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Typographical Conventions

The following typographical conventions are used throughout the documentation, both online 
and in the PDF documents.

Text

Convention Definition

Forward arrow symbol →
The forward arrow symbol → instructs you to select a series of menu items in a specific 
order. For example, Tools → Options is equivalent to: From the Tools menu, select Options.

Boldface font
A boldface font indicates that the given word(s) are shown that way on a toolbar button or 
as a menu selection. For example, if you are told to select a menu item in a particular order, 
such as File → Save Project, or to click Save.

Italic font
An italic font in the body of the text indicates the introduction of important terminology. 
Expect to find an explanation in the same paragraph or elsewhere in the guide. 

COMMAND

For features in Thermo-Calc that use Console Mode (i.e. the command line), this font and all 
capital letters indicates that this is a Console Mode COMMAND. Examples of how you can use 
a command are written with code font. For example:

Use DEFINE_ELEMENTS followed by a list of the elements that you want in your system. (To 
list the elements that are available in your current database, use LIST_DATABASE and choose 
Elements).

HELP
Text in blue and underline and a page number is a link to another topic in the current or 
referenced guide. Command names are often also topics. Clicking the link takes you to more 
detail about a particular command or subject in the PDF or documentation set.

<Enter>
Text with <angle brackets> indicates a keyboard entry. Usually to press <Enter> (or Return) 
or to use a series of keys such as <Ctrl + S>.

code and code bold

A code font shows a programming code or code example. The code bold font highlights the 
entry. It is also used for file names or paths to help distinguish it from other text. e.g. 

 l For Windows users, the documents, materials, examples and other folders that 
sometimes require additional licenses are installed in C:\Users\Public\Public 
Documents\Thermo-Calc\<version>."

click vs press
In general, you click with the mouse to perform an action on the screen (e.g. click Save) and 
you press keys on a keyboard to enter a set of commands  (e.g. press Ctrl+S).
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Convention Definition

When working in Console Mode, you can use keyboard shortcuts. 
Sometimes a window opens where you have the option to Save, Cancel or 
Open a file, for example. In these cases the instructions might say click 
Save, whereas you would need to press the applicable keys to perform the 
action.

Icons

Convention Definition

Important 
Provides important information. It is recommended that you read the text 
or follow the link.

License Required
This indicates that additional licenses are required for the feature, 
database, or example.

Note 
The information can be of use to you. It is recommended that you read 
the text or follow the link to more information.

Time
Indicates that something you are going to do will take some time, usually 
related to running an example.

Tip
This is general information that can be of use but is not required 
knowledge.
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Convention Definition

Read More
Read more at the link, which may be to our website or another source of 
general information.

See More
Go to the link or guide to see more general information about the topic 
being discussed.

Training
Indicates there may be training opportunities available, usually related to 
a specific feature. 

Link to more information Click the link to more information in the content.

Examples Go to the example collection to learn more.

Console Mode This note relates specifically to something in  Console Mode.

Video 
Indicates there is a video tutorial on our website, usually in relation to an 
example.

Graphical Mode This note relates specifically to something in  Graphical Mode.

Diffusion Module 
(DICTRA)

This indicates that the information relates to the Add-on Diffusion Module 
(DICTRA).

Precipitation Module (TC-
PRISMA)

This indicates that the information relates to the Add-on Precipitation 
Module (TC-PRISMA).

Process Metallurgy 
Module

This indicates that the information relates to the Add-on Process 
Metallurgy Module.
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Convention Definition

Property Models
This indicates that the information relates to the Property Models. This 
includes the Steel Model Library and Nickel Model Library as well as the 
general Models included with all installations.

Additive Manufacturing 
(AM) Module

This indicates that the information relates to the Add-on Additive 
Manufacturing (AM) Module.
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Using the Precipitation Calculator

In this section:

Precipitation Calculator 19

Define the Precipitation Calculator 21

Matrix Phase Settings 22

Selecting the Disordered Phase as a Matrix Phase 28

Precipitate Phase Settings 29

Particle Size Distribution (PSD) 36

Calculation Type Settings 42

Precipitation Calculator Thermal Profile 44

Guidelines for Importing Data Files to Thermal Profiles 48

Options Tab 50

Precipitation Calculator Plot Renderer 54

Pause, Resume, and Cancel Precipitation Calculations 62
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Precipitation Calculator

The Precipitation Calculator is available with three elements if you do not have the 
additional Precipitation Module (TC-PRISMA) license. With the Add-on Module you 
can use all available elements. See "Available Options" on page 9 for details about 
this and other options available with additional licenses.

A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation 
calculation. You can add the calculator to the System Definer directly (right-click and select it 
from the Create New Successor menu)

There is also a Precipitation template available under Non-Equilibrium that you 
can use to quickly set up a simulation.

Once you have added a Precipitation Calculator, the Configuration window has Conditions and 
Options settings tabs where there are many available conditions to set and then continue the 
settings with the specialized Plot Renderer.

Conditions

Set the conditions for your calculation that define the Matrix phase and Precipitate phase. 
Choose the Calculation Type. 

"Matrix Phase Settings" on page 22

"Precipitate Phase Settings" on page 29

"Calculation Type Settings" on page 42

Options

Modify Numerical Parameters that determine how the conditions are calculated.  

"Options Tab" on page 50
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Plot Renderer

There are also unique settings available for this calculator once you add a "Precipitation 
Calculator Plot Renderer" on page 54.

Working with these simulations is an advanced topic. It is recommended you 
review the  documentation and videos available or search for a specific topic. 

"Precipitation Module (TC-PRISMA) Examples Collection" on page 120
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Define the Precipitation Calculator

 1. Add a Precipitation Calculator node to the System Definer. If you used the Precipitation 
template (on the  My Projects Configuration window under Non-Equilibrium), click 
the node to display the Configuration settings window. 

 2. In the Precipitation Calculator Configuration window, enter the settings on the 
Conditions and Options tabs. These are described separately:

 l Matrix Phase

 l Precipitate Phase

 l Calculation Type and "Precipitation Calculator Thermal Profile" on page 44

 l Options Tab Advanced Settings

 3. Once you have finished defining the Precipitation Calculator, you also choose settings on 
the Plot Renderer. Some additional settings are specific to the "Precipitation Calculator 
Plot Renderer" on page 54.
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Matrix Phase Settings

Below are details about the settings available for the Composition and Matrix Phase, which is 
selected from the Conditions tab on the calculator Configuration window.

There are additional Conditions tab settings described for the Precipitate Phase 
and Calculation Type.

This is the three distinct settings areas for the Configuration window for example P_04_
Precipitation_Fe-C_Cemetite.tcu. In this case, Show Details is expanded to show the Precipitate Phase 
settings.

You can change these settings locally for a specific Calculator or globally for some 
defaults in the Options window (a different location than the tab). 

To open the Options window: 

 l Windows: Select Tools →  Options.

 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 
keyboard.

then click the Graphical Mode tab and the Precipitation node in the tree.

SHOW OR HIDE DETAILS

Click Show Details to view some of the additional settings listed below. You can also set the 
default to display in Phase view mode on the Options window then click the Graphical Mode 
tab and  the Precipitation node in the tree. Click Hide Details to hide the information.
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Composition Settings

COMPOSITION UNIT

Select the Composition unit: Mass percent, Mole percent, Mass fraction, or Mole fraction.

Matrix Phase Settings

"Selecting the Disordered Phase as a Matrix Phase " on page 28

PHASE

Only phases with kinetic data can be selected as the matrix phase. If the list is 
empty, go to the System Definer to confirm that both thermodynamic and kinetic 
databases are selected and defined.

Choose a Phase from the list. The list is based on the settings for the System Definer. When 
setting up a system, choose a matrix phase with kinetic data available in the database.

ELASTIC PROPERTIES

See "Homogeneous Nucleation" on page 69 for theory.

Choose Disregard to ignore the elastic properties.

Default elastic constants for Isotropic or Cubic are based on the major element of the alloy 
system. The elastic properties can affect nucleation rate, nuclei size, and particle shape.

 l For Isotropic, enter values for Shear modulus (in GPa) and Poisson's ratio as required.

 l For Cubic, enter values for c11, c12, and c44 as required.  are the elastic 
constants.

MOLAR VOLUME

Use the Database value (if the molar volume for the phase is defined in the thermodynamic 
database) or select User-defined to enter another value in m3/mol.
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If you select the Grain growth checkbox, see the separate Grain Growth Settings 
section for details.

GRAIN SIZE

If the Grain growth checkbox is NOT selected then this version of the Grain size 
section is available in order for the Average diameter of the grain size to be 
entered.

Grain size is the "diameter" of a grain. The Grain size value changes the available nucleation 
sites when Grain boundaries, Grain edges, or Grain corners is selected along with Calculate 
from matrix settings in the Precipitate Phase. Enter a numerical value and choose a unit from 
the list. The default is 1.0E-4 m.

See "Precipitation Morphology" on page 102 and "The Number of Available 
Heterogeneous Nucleation Sites" on page 80 for theory.

GRAIN ASPECT RATIO

For an elongated grain with a minor axis and a major axis, one may use the minor axis as grain 
size and the major/minor ratio as the grain aspect ratio to characterize the grain. The Grain 
aspect ratio value also changes the available nucleation sites when Grain boundaries, Grain 
edges, or Grain corners is selected along with Calculate from matrix settings in the Precipitate 
Phase. Enter a numerical value. The default is 1.0.

If the Grain growth checkbox is selected, the aspect ratio is fixed at 1.0 and can 
not be changed. See Grain Growth Settings.

See "Precipitation Morphology" on page 102 and "The Number of Available 
Heterogeneous Nucleation Sites" on page 80 for theory.
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DISLOCATION DENSITY

The Dislocation density value changes the available nucleation sites when Dislocations is 
selected along with Calculate from matrix settings in the Precipitate Phase. Enter a numerical 
value. The default is 5.0E12 m-2.

See "Precipitation Morphology" on page 102 and "The Number of Available 
Heterogeneous Nucleation Sites" on page 80 for theory.

MOBILITY ADJUSTMENT

The Mobility adjustment parameters modify the atomic mobility data from a database. 

Choose  Same for all elements, which  applies the adjustment to all elements, or Per element to 
adjust to each individual element. Then for the following settings, enter one set of values for 
Same for all elements, or individually for Per element.

 l Prefactor (unitless) is a parameter that multiplies to the mobility data from a database. 
This value scales the mobility by a constant amount. This can be useful, for example, 
when the material has a higher than normal vacancy concentration at the start of the 
precipitation simulation. (e.g. from a prior solutionizing and quenching treatment).

 l The Activation energy (J/mol) is a value that adds to the activation energy of mobility 
data from a database. This value scales the mobility by a temperature-dependent 
amount. Similar usage as the Mobility adjustment >Prefactor setting.

Grain Growth Settings

GRAIN GROWTH

Select the Grain growth checkbox to use this to calculate the temporal evolution of grain size 
distribution (GSD). The grains are assumed of spherical morphology when modeling the growth 
rates. Nucleation is not considered, thus an initial GSD is necessary to start the simulation.

After selecting the checkbox, there are additional settings made available as described in this 
section.



Precipitation Module (TC-PRISMA) User Guide

Using the Precipitation Calculator  ǀ 26 of 224

This checkbox is not available when a TTT diagram or CCT diagram Calculation 
Type is selected. 

See "Normal Grain Growth" on page 105 and "Zener Pinning" on page 107 for 
theory.

GRAIN SIZE >> GRAIN SIZE DISTRIBUTION

When the Grain growth checkbox is selected, then this version of the Grain size settings 
section is available. This is where you access the grain Size distribution settings.

Click Edit grain size distribution to open the Size distribution settings window. In this window, 
you can edit the parameters and generate a graph comparing the radius and number density 
for initial grains.

Select a Length unit: Meter, Micrometer, Nanometer, or Ångström.

Select a Distribution: Normal, Log normal, or From file.

 l If Normal or Log normal is selected, enter values for Mean radius and Std (standard 
deviation). The default Std is different for each choice.

 l If Hillert is selected, enter a value for the Mean radius.

 l If From file is selected, click Import and navigate to the file containing the required 
information and click Open. This file can be in .xls, .xlsx, .csv or .txt formats. The file 
should consist of two columns with values where the first column contains radius data 
and the second contains number density data.

A similar setup can also be found in  the "Particle Size Distribution (PSD)" on 
page 36.

Once the size distribution is defined, click Generate to view or update the graph comparing the 
radius and number density for initial grains.

GRAIN BOUNDARY ENERGY

This setting is available when the Grain growth checkbox is selected.

Enter a value for the Grain boundary energy. The default is 0.5 J/m2.
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See "Normal Grain Growth" on page 105 for theory.

GRAIN BOUNDARY MOBILITY

This setting is available when the Grain growth checkbox is selected.

The Prefactor (m4/Js) is a parameter that represents the magnitude of the grain boundary 
motion.

The Activation energy (J/mol) is a parameter that describes the temperature dependence of 
the grain boundary mobility.

See Grain Boundary Mobility Values for theory and recommended values.

ZENER PINNING

This setting is available when the Grain growth checkbox is selected. 

Select the Zenner pinning checkbox to consider the effect of precipitates on inhibiting normal 
grain growth. When this checkbox is selected, there are additional settings available in the 
Precipitate Phase section.

See "Zener Pinning" on page 107 for theory.

"P_14: Grain Growth and the Zener Pinning Effect" on page 209



Precipitation Module (TC-PRISMA) User Guide

Using the Precipitation Calculator  ǀ 28 of 224

Selecting the Disordered Phase as a Matrix Phase 

The following information is about using disordered FCC as a matrix phase with the following 
thermodynamic and mobility database packages:

 l TCCU and MOBCU (Cu-based alloys)

 l TCNI and MOBNI (Ni-based alloys)

In the TCNI/MOBNI and TCCU/MOBCU packages, the well-known order/disorder two-sublattice 
model is used to describe the Gibbs energy of both FCC_A1 and FCC_L12. With this treatment, 
FCC_L12 is becoming FCC_A1 if the site fractions of each element on both sublattices are 
identical, which means that FCC_A1 is only a special case of FCC_L12. Therefore, FCC_A1 is not 
shown in the phase list on the Phases and Phase Constitution tab on the System Definer activity 
and in subsequent equilibrium calculation results. Instead it is shown only as FCC_L12. The real 
ordered FCC_L12 is shown as FCC_L12#2.

In precipitation simulations, the matrix phase is quite often the disordered FCC phase. You can 
directly select FCC_L12 as the matrix phase and run a simulation. However, the speed is not  
optimal due to the sophisticated model used for both Gibbs energy and atomic mobilities. A 
better and more convenient way is to deselect FCC_L12 and FCC_L12#2 from the phase list on 
the Phases and Phase Constitution tab on the System Definer if the ordered phase is irrelevant 
in the alloy under investigation, such as in most  Cu alloys. Once these are unchecked (i.e. not 
selected), the FCC_A1 phase is available and can later be selected as the matrix phase.

For Ni-based superalloys using the TCNI/MOBNI package, the ordered FCC_L12#2 (gamma 
prime) has to be included as the precipitate phase in most of calculations. In this case, you can 
select DIS_FCC_A1 from the phase list on the Phases and Phase Constitution tab and then select 
it as the matrix phase in the Precipitation Calculator.
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Precipitate Phase Settings

Below are details about the settings for the Precipitate Phase, which is selected from the 
Conditions tab on the Precipitation Calculator Configuration window.

There are additional Conditions tab settings described for the Matrix Phase and 
Calculation Type.

To open the Options window: 

 l Windows: Select Tools →  Options.

 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 
keyboard.

then click the Graphical Mode tab and the Precipitation node in the tree.

SHOW OR HIDE DETAILS

Click Show Details to view some of the additional settings listed below. You can also set the 
default to display in Phase view mode on the Options window then click the Graphical Mode 
tab and  the Precipitation node in the tree. Click Hide Details to hide the information.

PHASE

The phases available to choose have both thermodynamic and kinetic data. If the 
list is empty, go to the System Definer to confirm that both types of databases are 
selected and defined.

Choose a Phase from the list. The list is based on the System Definer settings.

NUCLEATION SITES

See "Homogeneous Nucleation" on page 69 and "Heterogeneous Nucleation" on 
page 76 for theory.
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The number of different nucleation sites is dependent on the shape and size of grains in the 
matrix. Grain size is the "diameter" of a grain. Choose one of the following from the list.

 l Bulk, Grain boundaries,  Grain edges, Grain corners, or Dislocations.

 l For Grain boundaries, Grain edges, and Grain corners, enter the Wetting angle (0-90) 
in addition to the matrix settings. Wetting angle defines the deviation from spherical 
shape (or dihedral angle).

Click to select the Calculate from matrix settings checkbox to calculate the initial number 
density of sites from the matrix grain size or dislocation density.

To enter a specific value for the number of Nucleation sites, click to clear the checkbox.

INTERFACIAL ENERGY

See "Estimation of Coherent Interfacial Energy" on page 101 and "Interfacial Energy 
Anisotropy" on page 90 for theory.

Choose Calculated to use the estimated value. To adjust the estimate, enter a different 
prefactor or choose User-defined to enter a value in J/m2. For the User-defined option, you can 
also enter it as a function of radius (r) and temperature (T).

GROWTH RATE MODEL

Select Simplified, General, Advanced, Para-eq, NPLE, or PE Automatic (where Para-eq and PE 
are both abbreviations for paraequilibrium).

All models treat a particle (precipitate) of stoichiometric composition or with 
negligible atomic diffusivity. Except for the PE Automatic model, local equilibrium 
or paraequilibrium at the precipitate-matrix interface is assumed. The PE 
Automatic model enables smooth transition from paraequilibrium to local 
equilibrium.
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In the documentation and on the GUI, the abbreviations Para-eq and PE are both 
used for paraequilibrium. There is also the use of OE as an abbreviation for ortho-
equilibrium and LE for local equilibrium. 

See "Growth" on page 83.

MORPHOLOGY

See "Precipitation Morphology" on page 102 for theory.

Choose the particle shape: Sphere (default), Cuboid, Plate, or Needle. Options are based on the 
Elastic properties selected for the Matrix phase:

 l For a Cubic elastic property,  Sphere, Plate, Needle, and Cuboid are available.

 l For an Isotropic  elastic property, Sphere, Plate and Needle are available.

If Sphere is selected, there is an option to use a 3D → 2D conversion on the Plot or 
Table Renderer for certain variables. See "Stereology" on page 110 for theory 
details.

For Plate or Needle, select the Calculate aspect ratio from elastic energy checkbox or enter a 
numerical value in the Aspect ratio field to provide a constant aspect ratio.

See "Particle Shape Determination" on page 89 for theory.

Figure 1: The cuboid shape is described by a supersphere. Cuboids have six faces, which form a 
convex polyhedron.
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Figure 2: The plate is described as oblate spheroid. Oblate spheroids have rotational symmetry 
around an axis from pole to pole.

Figure 3: The needle shape is described as prolate spheroid. A prolate spheroid is a surface of 
revolution obtained by rotating an ellipse about its major axis.

TRANSFORMATION STRAIN

Choose Disregard to ignore the transformation strain. When Isotropic or Cubic is chosen in 
Elastic properties in Matrix Phase, you can also choose Calculated from molar volume to 
obtain a purely dilatational strain. If Plate or Needle is selected as the Morphology, you can 
alternatively choose User-defined and enter the properties for ε11, ε12, ε13, ε22, ε23, and ε33.

See "Particle Shape Determination" on page 89 for theory.

MOLAR VOLUME

Use the Database value (if the phase molar volume is defined in the thermodynamic database) 
or select User-defined to enter another value.
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ZENER PINNING PARAMETERS

These parameters are available when the Zener pinning checkbox is selected under the Matrix 
Phase settings.  These settings are to consider the effect of precipitates on inhibiting normal 
grain growth. 

 l Cutoff size: Precipitates with radius smaller than this value are neglected in pinning 
force calculation. Default value : 7 x 10-7 m.

 l Kinetic prefactor: Dimensionless kinetic coefficient in Zener equation. Default value: 
0.5.

 l Exponent: Exponent of precipitate volume fraction in Zener equation. Default value: 
0.93.

See "Zener Pinning" on page 107 for theory.

"P_14: Grain Growth and the Zener Pinning Effect" on page 209

PHASE BOUNDARY MOBILITY

A parameter that accounts for interface-controlled growth. Only effective if a very small, 
positive value is used. Use with caution due to a tentative treatment.

See "Simplified Growth Rate Model" on page 84 for theory.

TRANS-INTERFACE MOBILITY ADJUSTMENT

This setting is available when PE Automatic Growth rate model is selected.

The Trans-Interface mobility adjustment parameters modify the atomic mobility data from a 
database. 

Choose  Same for all elements, which  applies the adjustment to all elements, or Per element to 
adjust to each individual element. 
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The transition kinetics from Para-Equilibrium (PE) to Ortho-Equilibrium (OE) is 
controlled by the ratio of atomic mobility of substitutional elements to that of 
interstitial elements. This implies that the option of Same for all elements—while 
useful to the case that the atomic mobility data for all elements are needed to be 
scaled with the same factor to match experimental trans-interface mobility data—
does not change the PE-OE transition kinetics. Therefore, the change of transition 
kinetics separately requires adjustment of individual elements, which is when the 
Per element setting is useful.

Then for the following settings, enter one set of values for Same for all elements, or 
individually for Per element:

 l Prefactor (unitless) is a parameter that multiplies to the mobility data from a database. 
This value scales the mobility by a constant amount.  This results in the trans-interface 
mobility that controls the kinetics of Para-Equilibrium (PE) to Ortho-Equilibrium 
(OE) transition.

 l The Activation energy (J/mol) is a value that adds to the activation energy of mobility 
data from a database. This value scales the mobility by a temperature-dependent 
amount. Similar usage as the Trans-Interface mobility adjustment >Prefactor setting.

PHASE ENERGY ADDITION

An energy value that adds to the Gibbs free energy of the precipitate phase from a database.

See "Simplified Growth Rate Model" on page 84 for theory.

APPROXIMATE DRIVING FORCE

Select the checkbox to include this if simulations with several compositions sets of the same 
phase create problems.

See "Nucleation Theory" on page 68.
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PREEXISTING SIZE DISTRIBUTION

Select the checkbox to include this. Click Edit particle size distribution to open the Preexisting 
Particle Size Distribution window where you can edit the parameters and view a graph 
comparing the radius and number density for the selected component.

Press F1 and search for "Particle Size Distribution (PSD)" for detailed instructions.
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Particle Size Distribution (PSD)

"P_10: Initial Particle Size Distribution of Fe-Cr-C" on page 190

On the Precipitation Calculator you can set the pre-exisiting particle size distribution 
(PSD) parameters in the Show Details section. The size distribution can be generated from a 
probability distribution function, by importing a file, calibrating a probability distribution 
function to experimental data, or by manually entering information into a table. Uni-modal 
distributions can be created within the Graphical Mode interface. Pre-existing multimodal 
distributions can be loaded from a file. 

Accessing the 'Preexisting Size Distribution' Settings

 1. To the right of the Precipitate Phase settings fields, click Show Details.

 2. At the bottom of the Precipitate Phase section, click to select the Preexisting size 
distribution checkbox. Then click Edit Particle Size Distribution.
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 3. The Preexisting Particle Size Distribution window opens as shown for example P_10 
CEMENTITE phase.

Defining the Preexisting Size Distribution

Compositions

Choose a Dependent component from the list and enter the composition for the other 
component.

Size Distribution Settings

Length Unit

Choose a Length unit: Meter, Micrometer, Nanometer, or Ångström.

Amount of Phase

For all options, choose an Amount of phase: Volume percent or Volume fraction and then 
enter a number in the field.
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Input Type

Choose an Input type: Generate 3D PSD from distribution function, From File, or Approximate 
the 3D PSD from experimental data. See the following sections for the details about each 
setting.

Generate 3D PSD from Distribution Function

This option allows the generation of the size distribution from a list of probability distribution 
functions. The Distribution types include LSW, Normal, Log normal, and Weibull. 

 l Mean radius The mean particle radius. 

 l Sigma The standard deviation for the chosen length unit. 

 l Alpha A dimensionless shape factor that should vary between 1.5 and 10. 

 l Fraction offset The fraction offset applied to the mean radius to shift the start of the 
distribution. This must be greater than or equal to zero, and less than 0.95.

Once the Distribution is defined, click Generate to create the size distribution.

You can also click in the table to manually enter numbers into the cells rather than use one of 
the provided probability distribution functions. The radius values must monotonically increase 
in size.

From File

This option lets you load the initial size distribution from a file. Click Import and navigate to the 
file containing the required information and click Open. This file can be in .xls, .xlsx, .csv, or .txt 
formats. The file should consist of two columns with values where the first column contains 
radius data and the second contains number density data. 
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The example P_10 (available from the Example files → Precipitation Module - TC-
PRISMA  folder) shows this for the precipitate phase M23C6. There is also a file in 
this folder called P_10_Precipitation_Initial_PSD_FeCrC_psd_3D_M23C6.csv 
that is an example of a correctly formatted text file. 

The imported size distribution is normalized into a probability distribution function by ensuring 
that the zeroth moment is unity. If you wish to import a histogram that has un-even bin 
spacing, it is necessary to convert the Y-axis counts of the histogram to a count density first to 
avoid changes to the shape of the distribution. The count density is obtained simply by dividing 
the count of a bin by the bin's width. 

Approximate the 3D PSD from Experimental Data

The Approximate the 3D PSD from experimental dataInput type allows you to calibrate a 
continuous probability distribution function to an experimentally measured size distribution, 
and account for stereological considerations. There are additional settings related to this. 

DIMENSIONALITY OF EXP. DATA AND IMPORT EXP. DATA

The Dimensionality of exp. data setting must be defined. 

 l For precipitate radius measurements that are a good approximation of the 3D size of 
the particles, select 3D. Measurements from quantitative image analysis of Transmission 
Electron Micrographs (TEM) provide 3D size data, however the precipitates can still be 
truncated within the TEM sample foil thickness. 

 l 2D data is obtained from a cross section taken through the microstructure. Examples 
include micrographs taken from Scanning Electron Microscopy (SEM), and Optical 
Microscopy (OM). The radius measurements are obtained from calculating the 
equivalent radius of a circle from the areas of identified objects from quantitative image 
analysis of the micrographs. It is possible that the samples of interest are over-etched, 
revealing the full size of the precipitates. In this case the data may be more descriptive 
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of the 3D size, however smaller particles are removed by the etching, distorting the 
obtained size distribution.

 l 1D data is obtained from applying the linear intercept method to micrographs 
descriptive of a cross section through the dispersion. A half-linear intercept is used in 
this calculation, which is analogous to the radius of the particle, opposed to the 
diameter. 

Click Import exp. data to import the experimental data. Navigate to the file containing the 
required information and click Open. This file can be in .xls, .xlsx, .csv, or .txt formats.  The file 
should consist of two columns with values where the first column contains radius data and the 
second contains number density data. 

The example P_10 (available from the Example files → Precipitation Module - TC-
PRISMA  folder) shows this for the precipitate phase M7C3. There is also a file in 
this folder called P_10_Precipitation_Initial_PSD_FeCrC_psd_1D_M7C3.csv 
that is an example of a correctly formatted text file. 

DISTRIBUTION

Choose a Distribution: LSW (Lifshitz-Slyozov-Wagner), Normal, Log normal, or Weibull. 

Click Generate to calibrate the chosen Distribution to capture the Import exp. data accounting 
for the chosen stereological Dimensionality of exp. data.

For 3D data, there are two datasets shown in the preview; the experimental data and the 3D 
model data. For 2D and 1D data, the sectioned model data is also shown and compared with 
the experimental data
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The Optimization error is output into the text-field highlighted below. This can be used to determine 
the best distribution type to use for a given dataset.
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Calculation Type Settings

Below are details about the settings for the Calculation Type, which is selected from the 
Conditions tab on the Precipitation Calculator Configuration window.

There are additional Conditions tab settings described for the Matrix Phase and 
Precipitate Phase.

ISOTHERMAL

Use an Isothermal calculation type to do a simulation at constant temperature. 

These settings are described in the section for the "Precipitation Calculator 
Thermal Profile" on page 44.

NON-ISOTHERMAL

"Nucleation During a Non-isothermal Process" on page 82

Use a Non-isothermal calculation type to do a simulation with a user-defined temperature 
profile. You can enter information directly or import a data file.

These settings are described for the "Precipitation Calculator Thermal Profile" on 
page 44 including information about importing data files.

When you also have a license for the Additive Manufacturing (AM) Module you 
can  include probe data from the AM Calculator in the set up of the thermal profile. 

TTT DIAGRAM

Use a TTT-diagram to calculate the time-temperature-transformation (TTT) curve for the 
formation of the precipitate phase.
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 l Temperature: Enter Min, Max, and Step numerical values   and choose a temperature 
Unit.

 l Max annealing time: Enter a numerical value and choose a time Unit.

 l Stop criteria: Choose Volume fraction of phase or % of equilibrium fraction and then 
enter a numerical value. For each temperature, the simulation stops when the stop 
criteria is fulfilled or if the maximum annealing time is reached, whichever happens first.

See example "P_03: Stable and Metastable Carbides - TTT Diagram" on page 140

CCT DIAGRAM

Use a CCT-diagram to calculate the continuous-cooling-transformation (CCT) curve for 
precipitation.

 l Temperature: Enter Min and Max numerical values and choose a temperature Unit.

 l Cooling rate(s): Enter a range of values in the field, e.g..01 .1 1 10 100. These values 
are equal to K/s, °C/s or °F/s per second based on the temperature Unit selected.

 l Stop criteria: Enter a numerical value for the Volume fraction of phase. For each 
temperature, the simulation stops when the stop criteria is fulfilled.

See example "P_07: Continuous Cooling Transformation (CCT) Diagram of Ni-Al-Cr 
γ-γ’" on page 159.
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Precipitation Calculator Thermal Profile

The Thermal Profile is set up on the Configuration window for a Precipitation Calculator. The 
isothermal or non-isothermal profile is viewed in the Visualizations window. Choose Isothermal 
to do a simulation at constant temperature. Choose Non-isothermal to enter or import data for 
a user-defined temperature profile.

When connected to an AM Calculator (see Including Probe Data from an 
AM Calculator) the Isothermal and Non-isothermal options are not visible as it is 
not relevant to that view.

Isothermal Calculations

Many of the Graphical Mode examples for this Add-on Module are isothermal 
calculations, e.g. P_02_Precipitation_Fe-C-Cr_Cementite-M7C3-M23C6.

 1. On the Precipitation Calculator Configuration window, first enter the required Matrix 
Phase and Precipitate Phase settings. 

 2. Under Calculation Type, click to choose Isothermal to do a simulation at constant 
temperature. 

 3. Enter a Temperature and choose a unit (Kelvin, Celsius, or Fahrenheit). 

 4. Enter an End time and choose a unit: Seconds, Minutes, Hours, or Days. The Simulation 
time is displayed as text.

The profile is displayed on the Precipitation Calculator tab in the Visualizations window 
showing the constant temperature entered. 
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 5. For this calculation type this completes the settings you need to enter for the Thermal 
Profile. 

Non-isothermal Calculations

 1. On the Precipitation Calculator Configuration window, first enter the required Matrix 
Phase and Precipitate Phase settings. 

 2. Under Calculation Type, click to choose Non-isothermal to enter or import data for a 
user-defined temperature profile. 

 3. Select a Temperature unit: Kelvin, Celsius, or Fahrenheit.

 4. Enter an End time and choose a unit: Seconds, Minutes, Hours, or Days. The Simulation 
time is displayed as text.
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You can next either directly enter Time and Temperature coordinates into the table or 
import the information from a file. A minimum of two points is required. 

 5. To enter directly into the table:

 a. Click in each cell under the applicable columns, Time and Temperature then 
directly enter the values in the table.  

 b. Press <Enter> to add rows and use the scroll bars to navigate the table.

 6. To import a data file:

 a. Although it is a simple set of data, prepare the data file as in "Guidelines for 
Importing Data Files to Thermal Profiles" on page 48.

 b. When the data file is ready, to the right of the Import from file field, click the file 
 button. 

 c. Navigate  to a data file such as an MS Excel spreadsheet (with *.xls or *.xlsx 
extensions) or a *.csv file. You can also use other programs (e.g. Google Sheets) 
to enter data and export to a CSV format that can be read by the software. Click 
Open to import the data to the Configuration window table. 

 d. If there are issues with the above import, experiment with choosing the 
delimiter type that corresponds to the data in the file: Comma (,), Colon (:), 
Equals sign (=), Semicolon (;), or Tab. Click the Reload button . The data is 
imported to the Configuration window table.

 7. For this calculation type this completes the settings you need to enter for the profile, 
which is displayed on the Precipitation Calculator tab in the Visualizations window. 
Make adjustments to the settings as needed and watch it dynamically change in the 
window.
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This is from the non-isothermal calculation example, P_06_Precipitation_Ni-
Al-Cr_Non-isothermal_Gamma-Gamma_prime.

Including Probe Data from an AM Calculator

When you also have a license for the Additive Manufacturing (AM) Module you 
can  include probe data from the AM Calculator in the set up of the thermal profile. 

There is connectivity between the Diffusion Module (DICTRA) or the  Precipitation Module (TC-
PRISMA) and the Additive Manufacturing (AM) Module when you have full licenses available for 
all relevant Add-on Modules and databases. 

You can add a Diffusion Calculator or Precipitation Calculator as a successor to the 
AM Calculator and then when probes are included with the AM Calculator this data can be 
further used with the thermal profile. 
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Guidelines for Importing Data Files to Thermal 
Profiles

The Thermal Profile settings are done on the Configuration window for a Precipitation 
Calculator. The profile is then previewed in the Visualizations window. 

You can import data from a file.  There are specific guidelines needed to correctly prepare the 
data in this file to ensure it imports without errors. 

Data File Requirements

For a Thermal Profile you can either directly enter Time and Temperature coordinates into the 
table on the Configuration window, or import the data from a file. A minimum of two points is 
required. 

Although there are only two columns to define, it is still important to ensure the file is set up 
correctly.  In order for the data to be included in the calculation, the column and row definitions 
in the file must adhere to certain rules of entry. 

General Rules

 l No abbreviations are allowed in the header.

 l A header is not actually required in this file but in order to know which column is which, 
it is recommended to include it. 

 l All header text must be in English, i.e. no translations into other languages will be read 
correctly by the data file.

Only the columns described here are read / used in the calculation. It is important 
to enter the information exactly as described. It is recommended that the data file 
is cleaned up before importing / loading it and performing calculations. 
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Figure 4: This is an example of data entered into an Excel spreadsheet (which is then converted to csv 
format). Columns A and B show the data entered to create the Thermal Profile. 

 

Figure 5: The units shown on the Configuration window for the Time and Temperature correspond to 
settings that can ONLY be selected on the Configuration window. The data file does not contain any 
information about the units.

Column Heading Requirements and Options Row Cell Requirements  and Options

Time

This is column A as in Figure 4

Enter the text Time. No abbreviations allowed but it is not 
case sensitive. It is also not required but recommended to 
include so you know which column of data it applies to.

Valid  format and entries for each row in this column:

 l Any numerical input for the time that 
corresponds to the unit selected on the 
Configuration window e.g. 0.0, 773, 1000,  
1500, are times in seconds, which is the unit 
chosen in the example shown in Figure 5.

Temperature

This is column B as in Figure 4

Enter the text Temperature. No abbreviations allowed but it is 
not case sensitive. It is also not required but recommended to 
include so you know which column of data it applies to.

Valid  format and entries for each row in these columns:

 l Any numerical input for the temperature that 
corresponds to the unit selected on the 
Configuration window e.g. 1173, 1050, 1075,  
are temperatures in Celsius, which is the unit 
chosen in the example shown in Figure 5
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Options Tab

The Precipitation Calculator  settings including the section Numerical Parameters are located on 
the Configuration window → Options tab.

For equations and details about these settings, see "Numerical Method" on 
page 96.

You can change these settings locally for a specific Precipitation Calculator or 
globally for some defaults in the Options window settings. 

Preprocess Equilibrium  Data

Select the Preprocess equilibrium data checkbox to calculate the required phase equilibrium 
properties as a function of temperature for stable and metastable conditions. This speeds up 
the computation time of non-isothermal simulations or isothermal simulations where there is 
difficulty with losing precipitate phases during the calculation. 

When the  checkbox is selected, the stable and meta-stable property diagram data for all 
simulated precipitate phases is preprocessed. This preprocessing avoids repeating global 
equilibrium calculations, and speeds up computational time. It also allows for an improved 
description of precipitate kinetics under severe dissolution conditions. This can occur when 
temperatures are too high, where the phase is no longer detected in equilibrium calculations, 
or if the matrix is depleted of precipitate forming species, and the precipitate phase is lost 
when calculating the driving force.

This feature is used primarily for non-isothermal simulations. For isothermal simulations it can 
be used when there is difficulty losing precipitate phases during the calculation. In this case, it 
alters the predicted dissolution kinetics in certain conditions where the precipitation phase is 
lost and then it also speeds up these calculations.
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Include Incipient Melting

To use the Include incipient melting checkbox requires that the thermodynamic 
database (i.e. TCFE, TCNI, and so on) includes the liquid phase. If the liquid phase is 
not included, then the Perform button is not available (it is grayed out with a 
message explaining why) until either a liquid phase is included or this checkbox is 
deselected.

This is available when the Preprocess equilibrium data checkbox is selected.

Select the Include incipient melting checkbox to approximate the melting temperature of 
precipitate phases. The precipitates are removed upon exceeding this temperature.

Incipient melting is a phenomenon where, due to rapid heating rates, a solid-state precipitate is 
in solution at temperatures where it would normally dissolve. It liquidates rather than dissolves 
into the matrix. Being able to include (or exclude) the incipient melting is relevant to 
simulations involving welding and AM. Including incipient melting in AM calculations is useful to 
avoid excessive computation time modeling the dissolution of precipitates which would melt. 
The precipitates are assumed to melt instantaneously upon reaching their incipient melting 
temperature.

MAX TIME STEP FRACTION

The Max time step fraction is the maximum time step allowed for time integration as fraction 
of the simulation time. The default is 0.1.

NO. OF GRID POINTS OVER ONE ORDER OF MAGNITUDE IN RADIUS

The default number of grid points for every order of magnitude in size space. The default is 
150.0.

MAX NO. OF GRID POINTS OVER ONE ORDER OF MAGNITUDE IN RADIUS

The maximum allowed number of grid points in size space. The default is 200.0.

MIN NO. OF GRID POINTS OVER ONE ORDER OF MAGNITUDE IN RADIUS

The minimum allowed number of grid points in size space. The default is 100.0.
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MAX RELATIVE VOLUME FRACTION OF SUBCRITICAL PARTICLES ALLOWED TO DISSOLVE IN ONE TIME 
STEP

The portion of the volume fraction that can be ignored when determining the time step. The 
default is 0.01.

MAX RELATIVE RADIUS CHANGE

The maximum value allowed for relative radius change in one time step. The default is 0.01.

RELATIVE RADIUS CHANGE FOR AVOIDING CLASS COLLISION

Set a limit on the time step. The default is 0.5.

MAX OVERALL VOLUME CHANGE

This defines the maximum absolute (not ratio) change of the volume fraction allowed during 
one time step. The default is 0.001.

MAX RELATIVE CHANGE OF NUCLEATION RATE IN LOGARITHMIC SCALE

This parameter ensures accuracy for the evolution of effective nucleation rate. The default is 
0.5.

MAX RELATIVE CHANGE OF CRITICAL RADIUS

Used to place a constraint on how fast the critical radium can vary, and thus put a limit on time 
step. The default is 0.1.

MIN RADIUS FOR A NUCLEUS TO BE CONSIDERED AS A PARTICLE

The cut-off lower limit of precipitate radius. The default is 5.0E-10 m.

MAX TIME STEP DURING HEATING STAGES

The upper limit of the time step that has been enforced in the heating stages. The default is 
1.0 s.
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MAXIMUM RELATIVE SOLUTE COMPOSITION CHANGE AT EACH TIME STEP

Set a limit on the time step by controlling solute depletion or saturation, especially at the 
isothermal stage. The default is 0.01. 
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Precipitation Calculator Plot Renderer

The following is information about the settings available for a Plot Renderer when it is a 
successor to a Precipitation Calculator.

Plot Settings

LEGEND OPTION

Select whether the diagram’s legend displays On or Off.

AXIS VARIABLE

Set the state variable you want plotted along the X-axis and the Y-axis. The available variables 
in the list are based on how your system is set up.

Below are additional details related to the Axis variable chosen.

 l Separate Multimodal PSD: If you select Mean radius, Number density, Volume 
fraction, Size distribution, Number density distribution, or Normalized number density 
distribution then the Separate multimodal PSD checkbox is available. For variables with 
time for the X-axis, the number of Points used to sample the results can be modified. 
The Inflection neighbors and Smoothing iterations are used to identify individual 
particle populations. See Separate Multimodal PSD below for more detail.

 l 3D → 2D: For a spherical morphology, and if you select Mean radius, Number density, 
Volume fraction, Size distribution, Number density distribution, or Normalized 
number density distribution as an axis variable, you can also select the 3D → 2D 
checkbox to convert the 3D property to the corresponding 2D property considering the 
resulting 2D size distribution obtained from sectioning a 3D spherical dispersion. See 3D 
to 2D Conversion below for more detail.

 l Yield Strength: If you select this as an axis variable there are additional settings. See 
Yield Strength below for more detail.
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Yield Strength

If you choose Yield strength as an Axis variable, you can further define the model. Click to 
expand the drop down list to the right of the Axis variable, then select any or all of the 
checkboxes listed below to plot the respective contributing elements to the yield strength. 

Click Configuration Panel toggle between the settings options and to further fine-tune the 
model.  The greyed out sections (e.g. the Matrix,  Precipitate phases, and Grain size) are defined 
on the Precipitation Calculator and cannot be changed.

To see these settings after clicking Configuration Panel, you need to expand the 
Plot Renderer Configuration window to the right. Either detach the window to 
resize, or hover with the mouse until you see the double arrow, then click and drag 
to expand the window.

 l Total yield strength

 l Intrinsic strength

 l Solid solution strengthening

 l Solid solution strengthening FCC

 l Solid solution strengthening BCC

 l Solid solution strengthening HCP

 l Grain boundary strengthening

 l Total precipitation strengthening

 l Precipitation strengthening per phase

 l Constant strength addition
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The P_01: Isothermal Precipitation of Al3Sc example demonstrates the use of this 
Yield Strength Model.

Separate Multimodal PSD

This setting is available if you select Mean radius, Number density, Volume fraction, Size 
distribution, Number density distribution, or Normalized number density distribution as the 
Axis Variable.

When the Separate multimodal PSD checkbox is selected on a Plot Renderer activity for the 
Precipitation Calculator, the size distribution is evaluated at the given time steps and results 
for individual particle populations are identified and presented. These are separated and used 
to calculate the specified property.

"P_06: Precipitation of γ’ in Ni Superalloys - Non-isothermal" on page 152

It can be applied on the following plot properties:

 l Mean radius

 l Size distribution

 l Number density

 l Volume fraction
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POINTS

This field is available when Mean radius, Number density, or Volume fraction is selected as the 
Axis variable and the Separate multimodal PSD checkbox is selected. Since the evaluation of 
multimodality at each time step is costly, you can specify how many evaluation Points to use. 
The points are geometrically distributed over the time scale where nucleated particles are 
found. The default is 40 points.

INFLECTION NEIGHBORS

This setting is available when the Separate multimodal PSD checkbox is selected.

Enter the Inflection neighbors, which are the number of neighboring points with consistent 
gradient direction to identify inflection points. The default is 6. As a guide, too low a number is 
sensitive to noise and too high a number can fail to detect particle populations.

SMOOTHING ITERATIONS

This setting is available when the Separate multimodal PSD checkbox is selected.

Enter the number of Smoothing iterations performed to reveal significant particle populations. 
The default is 500. As a guide, too small a number can fail to remove noise, and too high a 
number can remove the particle populations of interest.

3D to 2D Conversion

When the Precipitate Phase Morphology is set to Sphere on the Precipitation Calculator, the 
following options are available when certain axis variables are also selected.

Select the 3D → 2D checkbox if you want to make a direct comparison between the predicted 
three-dimensional (3D) radius of the precipitates and the two-dimensional (2D) data obtained 
from a cross-section taken through the dispersion.

The stereological conversion is described in the theory for spherical particles. See 
"Stereology" on page 110.

These variables can be converted to 2D:
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 l Mean radius: The average circular radius of cross sections of particles obtained by 
taking a section through the dispersion, assuming spherical precipitates.

 l  Number density The number concentration of precipitates found on a 1 m2 cross-
section through the microstructure.

 l  Volume fraction The area fraction of precipitates found on a cross-section  taken 
through the microstructure.

 l Size distribution: The number density of particle cross sections that have a radius 
varying within a given size class in a unit area.

 l Number density distribution: The number of particle cross sections that have a radius 
varying within a given size class in a unit area.

 l Normalized number density distribution: The probability of finding particle cross 
sections with a cross sectional radius varying within the size class. The radius is 
normalized by the volumetric mean of the dispersion.

AXIS TYPE

Select the type of axis scale: Linear, Logarithmic, Logarithmic 10, or Inverse.

LIMITS

Specify the range along the axis to show in the plot. In the fields, enter the minimum and 
maximum values of the axis variable. You can also determine the step size between the tick 
marks along each axis.

Select the Automatic scaling checkbox to allow the program to set the limits.

UNIT (TIME X AXIS)

Choose a Unit: Seconds, Hours, or Days.

ADD AN AXIS AND REMOVE THIS AXIS BUTTON

Use the Add an axis  and Remove this axis  buttons to add additional X- and/or Y-axes to a 
plot or to merge plots (to overlay one plot with another in the same diagram). When merging 
plots, you define this variable as the Z-axis.
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AXIS VARIABLES

 l Mean radius: Spherical radius of average volume of all particles for a specific phase and 
nucleation type, regardless of their actual shapes. If the matrix phase is selected, it 
outputs the average grain radius.

 l Critical radius: Spherical radius of critical nuclei for a specific phase and nucleation type. 
If the matrix phase is selected, it outputs critical grain radius.

 l Yield strength: To use the Yield Strength Property Model to calculate yield stress. 

 l Matrix composition: Instantaneous compositions of the matrix phase.

 l Precipitate composition: To track the instantaneous composition of precipitate 
particles. In particular, it is useful to distinguish different composition sets of the same 
phase (for example, FCC_A1#2 and FCC_A1#3). Further choose Solutes or All.

 l Number density: Instantaneous number of particles per unit volume for a specific phase 
and nucleation type. If the matrix phase is selected, it outputs instantaneous number of 
grains per unit volume.

 l Size distribution: Number of particles, or grains if the matrix phase is selected, varying 
with their sizes per unit volume per unit length, for a specific phase and nucleation type, 
at a specific time.

 l Number density distribution: Retrieve the number density (number of particles per unit 
volume) of precipitates, or grains if the matrix phase is selected, distributed in different 
particle sizes.

 l Normalized Number density distribution: Retrieve the number density (number of 
particles per unit volume) of precipitates, or grains if the matrix phase is selected, 
normalized by total number of particles or grains per unit volume, distributed in 
different particle sizes normalized by average size.

 l Volume fraction: Instantaneous volume fraction for a specific phase and nucleation 
type.

 l Nucleation rate: Instantaneous number of nuclei per unit volume per unit time for a 
specific phase and nucleation type.

 l Normalized driving force: Instantaneous nucleation driving force per unit mole of 
elements for a specific phase and nucleation type. It is normalized with RT and 
therefore, dimensionless.

 l Temperature

 l Mean cubic factor: Average cubic factor of cuboid particles. Available only when cuboid 
is selected as the Morphology.
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The following settings area available as indicated when Needle, Plate, or Cuboid are selected as 
the Morphology in the Precipitate Phase section on the Precipitation Calculator.

 l Cubic factor distribution: Variation of cubic factor with particle size at a specific time. 
Available with a cuboid morphology.

 l Mean aspect ratio: Average aspect ratio of non-spherical particles. Available with a 
needle or plate morphology. Note that this is always larger than 1, where 1 = a sphere.

 l Mean particle length: Diameter of non-spherical particles along the longer axis. 
Available with a needle or plate morphology.

 l Aspect ratio distribution: Variation of aspect ratio with particle size at a specific time. 
Available with a needle or plate morphology.

TIME

This field is available when Size distribution or Number density distribution is selected as the 
Axis variable. Enter one or a series of numbers in the field, separated by a space.

"P_09: Precipitation of Al-Sc AL3SC with Assumption of Sphere and Cuboid 
Morphologies" on page 175

For example, if you enter 100.0 1000.0 1.0E7 in the field:

When you click Perform the times are plotted:
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Pause, Resume, and Cancel Precipitation 
Calculations

Precipitation calculations are often complex  simulations that take some time to complete. 
Sometimes you may want or need to pause or resume a calculation, or make adjustments to 
your compositions and start again. You pause and resume from the Precipitation Calculator 
Configuration window. 

To Pause and Resume a Job

 1. Run the job (i.e. click Perform Tree). In the Scheduler, you can see the job listed and in 
the Event Log you can follow the progress of the calculation. 

 2. In the Project window, click the Precipitation Calculator node. 

 3. In the Configuration window at the bottom, click Pause. Observe that the Precipitation 
Calculator in the Project window has a pause indicator. If there are intermediate results 
available these will be listed in the Event Log. 
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 4. When pausing the calculation, you can make changes to a variety of settings under the 
Matrix Phase or Precipitate Phase sections (click Show Details), plus the Interfacial 
energy, Temperature (for non-isothermal calculations), and Simulation time. The rest of 
the Configuration window settings are grayed out and no other editing can be done 
while paused.

 5. When ready, click  Continue to resume your calculations from the last time step or 
click  Discard to discard the calculation (then click Yes or No on the window that 
opens).
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To Cancel a Job

 l In the Scheduler window, right-click the job you want to cancel and select Cancel Job.
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Theoretical Models and Numerical Methods

In this section:
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Theory Overview

Based on the theory from Langer-Schwartz [1980Lan] the Precipitation Module (TC-PRISMA) 
adopts Kampmann-Wagner numerical (KWN) [2013Wag]  method to simulate the concomitant 
nucleation, growth, and coarsening of precipitates in multicomponent and multiphase alloy 
systems. The KWN method is an extension of the original Langer-Schwartz (LS) approach and its 
modified (MLS) form, where the temporal evolution of the mean radius and particle density 
over the whole course of precipitation are predicted by solving a set of rate equations derived 
with certain assumptions for the rates of nucleation and growth, as well as the function of 
particle size distribution (PSD). The MLS approach differs from the LS with respect to the Gibbs-
Thomson equations used for calculating equilibrium solubilities of small particles. The former 
applies the exact exponential form, whereas the latter takes the convenient linearized version. 
Instead of assuming a PSD function a priori and working with rate equations for determining 
only mean radius and particle density, the KWN method extends the LS and MLS approaches by 
discretizing the PSD and solving the continuity equation of the PSD directly. Therefore, the time 
evolution of the PSD and its nth moment (0: number density; 1st: mean radius; 3rd: volume 
fraction) can be obtained altogether during the simulation. The key elements of the KWN 
method are the models for nucleation and growth under the mean field mass balance condition 
and the numerical algorithm for solving the continuity equation of the PSD. Coarsening comes 
out naturally without any ad hoc treatment.

The key elements of the KWN method and their relationship as implemented in the Precipitation 
Module (TC-PRISMA).



Precipitation Module (TC-PRISMA) User Guide

Theoretical Models and Numerical Methods  ǀ 67 of 224

Integration of the Precipitation Module into Thermo-Calc

Precipitation Module (TC-PRISMA) is integrated with Thermo-Calc  in order to directly get all 
necessary thermodynamic and kinetic information required in the KWN method. For industry 
relevant multicomponent alloys, thermodynamic and kinetic databases and calculation tools 
have to be used in order to obtain various quantities in the multicomponent models for 
nucleation and growth, such as the driving forces for the formation of embryos and their 
compositions, the atomic mobilities or diffusivities in the matrix, the operating interface 
compositions under local equilibrium  conditions, the Gibbs-Thomson effect, and the deviation 
from local equilibrium due to interface friction etc. With Thermo-Calc and the Diffusion Module 
(DICTRA) as well as the accompanying databases, all these properties and effects can be 
calculated without unnecessary and inaccurate approximations. 

In the following topics, various models and numerical methods implemented in Precipitation 
Module (TC-PRISMA) are introduced. Unless specified, spherical particles are assumed in the 
discussion.

References
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Nucleation Theory

Precipitation starts from the nucleation of clusters that can be considered as embryos of new 
phases with distinctive structures or compositions. In a perfect single crystal, nucleation 
happens homogeneously. In an imperfect crystal or polycrystalline materials, nucleation tends 
to occur heterogeneously due to the presence of dislocations, grain boundaries, grain edges, 
and grain corners. These imperfections or defects reduce the nucleation barrier and facilitate 
nucleation. However, if supersaturation or driving force is very large homogeneous nucleation 
is also possible since all sites including those inside a grain can be activated.

The following sections further elaborate on this theory.

 l "Homogeneous Nucleation" on the next page

 l "Heterogeneous Nucleation" on page 76

 l "Nucleation During a Non-isothermal Process" on page 82
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Homogeneous Nucleation

The  classic nucleation theory (CNT) [2000, Kashchiev;  1980, Russell]  has been extended for the 
purpose of modeling nucleation in multicomponent alloy systems. The time-dependent 
nucleation rate   is given by 

[Eq. 1]         

where 

 l  is the steady state nucleation rate, 

 l  is the incubation time for establishing steady state nucleation conditions, and 

 l  is the time. 

The steady state nucleation rate  is expressed by 

[Eq. 2]         

where 

 l  is the Zeldovich factor,

 l  is the rate at which atoms or molecules are attached to the critical nucleus,

 l  is the number of available nucleation sites (of a particular type) per unit volume. In 
the case of homogeneous nucleation, initially, each atom in the whole volume of the 
mother phase is a potential nucleation site. As precipitation proceeds, the number of 
available nucleation sites decreases due to the occupancy of part of the matrix volume 
by formed secondary phase particles. In the case of heterogeneous nucleation, the 
initial number can also be estimated, given the grain size or dislocation density  in the 
matrix phase. It decreases also with time but at different rates.

 l  is the Gibbs energy of formation of a critical nucleus, 

 l  is Boltzmann’s constant,

 l  is absolute temperature. 

The Gibbs energy of formation of a critical nucleus is expressed as 

[Eq. 3]         
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where 

 l  is the interfacial energy, 

 l  is the molar Gibbs energy change for the formation of the β precipitate of the 
critical composition  from the  matrix, i.e. the maximum driving force for the  

phase transformation

 l  is the molar volume of the β precipitate phase. 

If elastic strain energy is excluded,  is the chemical driving force for nucleation. There are 
two ways to calculate the nucleation driving force    and the critical composition , as 

shown in Figure 6 for a prototype binary system. The standard calculation in Figure 6 is to 
obtain the maximum driving force by finding the parallel tangent lines or surfaces passing 
through the alloy composition of the   matrix, which is a routine calculation in the Thermo-Calc 
software. The approximate calculation in Figure 6 is performed by using the Gibbs energy 
difference corresponding to the equilibrium composition in the precipitate phase. It can be 
used when the standard calculation fails, mostly within a miscibility gap. Additionally, the 
standard calculation is also used for driving force under paraequilibrium conditions, while the 
approximate calculation is used for driving force under NPLE (Non-Partitioning Local 
Equilibrium) conditions.

"Growth" on page 83
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Figure 6: Methods to calculate the nucleation driving force   and the critical composition . 

The standard calculation (left) and an approximate calculation (right).

Nucleation is a stochastic process and can be considered formally as a diffusion process or 
Brownian movement in the particle size space. Supercritical nuclei with radius slightly larger 
than the critical radius have a probability of passing back across the free energy barrier and 
dissolve in the matrix. The Zeldovich factor ( ) is a measure of such probability and is related 
solely to the thermodynamics of the nucleation process in 

[Eq. 4]         

where  is the Avogadro number and , the critical radius, is given by 

[Eq. 5]         

The atomic or molecular attachment rate  reflects the kinetics of mass transport in the 
nucleation process and is given by  Svoboda et al. [2004Svo].

[Eq. 6]         

where
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 l  is the lattice parameter, 

 l and are the mole fractions of element i at the interface in the precipitate and 

matrix, respectively. 

 l  is the corresponding diffusion coefficient in the matrix.

The incubation time  for an isothermal reaction is 

[Eq. 7]         

where  differs from one derivation to another. The value 2 from Feder et al. [1966Fed] is 
adopted. 

Elastic Strain Energy

Elastic strain energy, , reduces the nucleation driving force,   in Eq. 3, hence affecting 
nucleation rate and nuclei size. It also changes the shape of the particle by competing with 
interfacial energy. 

Cuboid Particle

"Precipitation Morphology" on page 102

The numerical simulations by Onaka et al. [2003Ona] indicate that the elastic strain energy is 
reduced almost linearly with increasing  cubic factor . Since the numerical simulations are 
computationally expensive, we assume that the elastic strain energy follows the linear 
relationship with , and the elastic strain energy for spherical ( ) and cubic (  ) are 
calculated based on Khachaturyan’s approximation [1983/2008Kha].

[Eq. 8]         

where

 l  is the lattice misfit strain,

 l  are elastic constants in a cubic system,

 l  is particle volume,

 l  and  are expressed as
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with

Sphere

Cubic

Ellipsoidal Particle (Plate and Needle)

"Precipitation Morphology" on page 102

Since they are ellipsoidal shape, it is convenient to use Eshelby’s theory [1957/1959Esh] with a 
reasonable computational cost. The Eshelby’s tensor can be calculated by simply performing a 
surface integral over a unit sphere

[Eq. 9]         

where 

 l  are ellipsoid axes,

 l  are unit directional vector normal to the spherical surface and 

For matrix phase with cubic crystal symmetry, we have for  . See  [1983Kha].

where

The Eshelby S tensor can then be calculated as

[Eq. 10]         
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The total strain   at each location inside the particle is related to its transformation strain 
(eigenstrain)   as

[Eq. 11]         

Combined with elastic stress calculated as

The elastic strain energy can be then obtained

[Eq. 12]         

with  the particle volume.

Spherical Approximation for Nuclei

In the Precipitation Module, the user-input or calculated interfacial energy is assumed to be the 
coherent interfacial energy that applies to the habit plane, , consistent with the 

approximation made by the embedded interfacial energy model. When calculating the critical 
nuclei, the interfacial energy in Eq. 3 is assumed to be that of a spherical particle with constant 
specific interfacial energy . This is consistent with the fact that the nuclei tend to be 

spherical due to dominant interfacial energy. Interfacial energy penalty assuming a nucleus 
with pre-defined, and most likely large, aspect ratio is thus over-estimated, and has been found 
to shut down nucleation event abnormally.

Under spherical approximation, the elastic strain energy is calculated using spherical expression 
in Eq. 8 for spherical and cuboidal particles, or by setting  in Eq. 9 for ellipsoidal 
particles.
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Heterogeneous Nucleation

All equations remain the same for the calculation of heterogeneous nucleation rate within the 
framework of classic nucleation theory (CNT), but the nucleation energy and available 
nucleation site are different.

To a first approximation, the nucleation energy may be calculated by assuming an effective 
interfacial energy for each heterogeneous nucleation site. 

For a rigorous treatment of heterogeneous nucleation the effect of wetting angles need to be 
considered.

Non-Spherical Particles and the Effect of Wetting Angle

"Precipitation Module (TC-PRISMA) References" on page 117

Non-spherical particles have been considered for grain boundary (GB) precipitation. Three 
morphologies are implemented for grain boundary, grain edge and grain corner precipitation, 
respectively, as shown in Figure 7. The parameter that defines the deviation from spherical 
shape is wetting angle (or dihedral angle), , as described in Figure 8 and taken from Clemm 
and Fisher [1955Cle].

         (a)                                 (b)                                                          (c)

Figure 7:  Non-spherical particles (β) that precipitate at grain boundaries of matrix phase( ) (a) grain 
boundary (two-grain junction) (b) grain edge (three-grain junction) (c) grain corners (four-grain 
junction). Images  from [2004Zan].
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Figure 8: The nucleus at the grain boundary. Image from  [1955Clem].

Some physical parameters, mainly in nucleation models, have to be modified for the effect of 
the wetting angle. The following discussions contribute to this effect.  

Shape Factors

Following Clemm and Fisher, the eliminated grain boundary area between  grains due to 
the formation of nucleus of a new phase β is:

[Eq. 1]         

Where   is the radius of curvature of the nucleus. The surface area of the nucleus is:

[Eq. 2]         

and the volume of the nucleus is

[Eq. 3]         

The expression of , ,   in Eq. 1 and Eq. 3 for grain boundary (two-grain junction), grain edge 
(three-grain junction) and grain corner (four-grain junction) can be found in the paper by 
Clemm and Fisher [1955Cle].

Critical Radius and Activation Energy

The energy change due to the formation of the new particle is thus

[Eq. 4]         

where  and  are the interfacial energy and grain boundary energy, respectively. 

Then the critical radius should be



Precipitation Module (TC-PRISMA) User Guide

Theoretical Models and Numerical Methods  ǀ 78 of 224

[Eq. 5]         

And the activation energy barrier for nucleation is

[Eq. 6]         

The interfacial energy, grain boundary energy and wetting angle can be related as

[Eq. 7]         

i.e.

[Eq. 8]         

which can be replaced into Eq. 5 and Eq. 6.

[Eq. 9]         

[Eq. 10]         

The bulk, spherical precipitation equation is recovered by:

[Eq. 11]         

so that

[Eq. 12]         

[Eq. 13]         

And also the grain boundary precipitation with spherical shape (with weighting angle ) 
follows Eq. 12 and Eq. 13 by .

Zeldovich Factor

The Zeldovich factor is modified as 
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[Eq. 14]         

with  the original value, and  the volume factor that is the ratio of the   in Eq. 3 to the 
spherical shape factor .

[Eq. 15]         

Impingement Rate

The surface area factor in impingement rate calculation is changed from  to .

Nucleation Site Density

In each time step, the occupied grain boundary area

[Eq. 16]         

is deducted when calculating available nucleation site density.

Growth Rate

The radius  defined in previous equations is the curvature of the precipitate surface (the Big 
radius) as shown in Figure 8. It is exactly the definition in the growth rate whose coarsening 
consideration relates to the curvature effect. Therefore, the growth rate equation can be 
directly used with  being defined here. Again, for bulk, spherical precipitation it automatically 
corresponds to the particle radius.

Output

The volume of the precipitate should be calculated appropriately as with  being the 
curvature of the particle surface as defined above. For output of the particle size (mean radius, 
critical radius and particle size distribution) in the user interface, it seems better to use the 
radius of the eliminated grain boundary area, i.e.

[Eq. 17]         

With  defined in Eq. 1. 

For example, the size of the precipitate at grain boundary (two-grain junction) is the radius of 
the lens shown in Figure 8. 
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The Number of Available Heterogeneous Nucleation Sites

Figure 9: An example of tetrakaidecahedron approximation of grains.

The number of different nucleation sites is dependent on the shape and size of grains in the 
matrix. Assuming all grains are equally large tetrakaidecahedra with the distance between one 
pair of square faces as H, and that between the other two pairs as D we obtain the densities , 

, and  for the grain boundary area, edge length, and grain corner number, respectively in 

[Eq. 18]         

[Eq. 19]         

[Eq. 20]         

where    is the aspect ratio, defining the degree of elongation of the grains. 

By default, the aspect ratio is set to 1 and the densities are then the same as obtained by Cahn 
[1956Cah].  Once the densities are known, if taking boundary thickness as one atomic layer, the 
available nucleation sites can be calculated by 

[Eq. 21]         

where   is the molar volume of the matrix phase and  is the Avogadro number. 

For a crystalline material, given a dislocation density , the number of nucleation sites at the 
dislocations  can be calculated with the same form as in 

[Eq. 22]         
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Nucleation During a Non-isothermal Process

Under non-isothermal conditions, temperature dependency of key parameters such as 
nucleation driving force, solute diffusivities and solute concentrations, etc., have been taken 
into account, and are updated automatically during a simulation. 

Another important parameter that depends on thermal history is the incubation time, defined 
by 

[Eq. 1]          

for an isothermal condition. In a non-isothermal process, the exact calculation of the incubation 
time requires a solution to the Fokker-Planck equation. In the Precipitation Module, an 
approximation approach has been employed to deal with the transient nucleation, which gives 
the incubation time as an integral form of past thermal history [2004Jou] as in  

[Eq. 2]         

where 

 is the incubation time,  is the impingement rate for solute atoms to the critical cluster as 
defined in 

[Eq. 3]          

and  is the Zeldovich factor, previously defined in 

[Eq. 4]          

but now as a function of  derived from temperature change. 

The starting point of the integral  is either the starting time if there is an initial nucleation 
driving force, or the latest time when the nucleation driving force is vanished.
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Growth

Spherical Particles

The growth rate models implemented in the Precipitation Module are called Advanced, 
Simplified, General, Para-eq, NPLE, and PE Automatic. All models treat a spherical particle 
(precipitate) of stoichiometric composition or with negligible atomic diffusivity. 

All models treat a particle (precipitate) of stoichiometric composition or with 
negligible atomic diffusivity. Except for the PE Automatic model, local equilibrium 
or paraequilibrium at the precipitate-matrix interface is assumed. The PE 
Automatic model enables smooth transition from paraequilibrium to local 
equilibrium.

In the documentation and on the GUI, the abbreviations Para-eq and PE are both 
used for paraequilibrium. There is also the use of OE as an abbreviation for ortho-
equilibrium and LE for local equilibrium. 

Advanced Growth Rate Model

The Advanced model is proposed by  Chen, Jeppsson, and Ågren (CJA) [2008Che]. In this model, 
the velocity of a moving phase interface and the operating tie-line are solved together from  
flux-balance equations. This model can treat both high supersaturation and cross diffusion 
rigorously. It can also capture  the transition between NPLE (non-partitioning local equilibrium) 
and PLE (partitioning local equilibrium)  without any ad hoc treatment.  

According to the CJA model, the interface velocity   can be obtained together with interface 
concentrations by numerically solving  equations, comprising of the flux balance 
equations for  independent components and the local equilibrium conditions for all  
components as in 

[Eq. 1]         

[Eq. 2]         

where 
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 l and  are the volume concentrations of component  at the interface in the 

precipitate and matrix, respectively, 

 l  is the corresponding atomic mobility in the matrix, 

 l  and are the chemical potentials in the matrix of the mean-field concentration 

and at the interface, respectively. 

 l is the chemical potential at the interface in the precipitate. 

In the above local equilibrium condition, the multicomponent Gibbs-Thomson effect has been 
taken into account by adding a curvature induced pressure term to the Gibbs energy of the 
precipitate phase. 

The introduced effective diffusion distance factor, , for each independent component is given 
by 

[Eq. 3]         

where 

is the so-called dimensionless supersaturation for an individual component, and  is obtained 
via 

[Eq. 4]         

Simplified Growth Rate Model

In some cases, the Advanced model fails to find the solution to flux-balance equations. Even 
when it does, the calculation can be time consuming. Therefore, a simple and efficient, albeit 
less rigorous, model is preferred in many applications. The Simplified model [2022Ågr], in a 
pseudo-steady state approximation, is developed by solving Laplace equation along radial 
direction, and is expressed as

[Eq. 5]         

where  is the nucleation driving force and  is the radius of critical nuclei.  is the kinetic 
parameter that is related to solute composition and mobility. Neglecting cross diffusion, it is 
expressed as
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[Eq. 6]         

The interface compositions (mole fractions)  and  for precipitate and matrix 

phase, respectively, are tie-line compositions across the matrix composition. To avoid time-
consuming equilibrium calculations and also realizing that precipitate composition  only 

appears in the difference term 

Equation 6 is further simplified by replacing  with nuclei composition from nucleation 

driving force calculation, and  with matrix composition.

The  constant defined here relates growth rate to driving force in 

, which is not to be confused with coarsening rate constant 
relating mean particle radius cubed to time.

For the Precipitation Calculator → Precipitate Phase settings, Phase energy addition   and 
Phase boundary mobility   shifts the Gibbs energy of the precipitate  phase by 

. As a result, the driving force  is reduced by , and the 

equilibrium compositions  and  are shifted. 
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Figure 10: Effects of “Phase energy addition”  and “Phase boundary mobility” .

General Growth Rate Model

The General model is based on the existing coarsening models [1993Uma; 1994Mor; 1995Mor], 
which follows the same quasi-steady state approximation as the Simplified model, but 
improves by taking into account the cross diffusion. The growth rate equation has thus the 
same format as that in the Simplified model, i.e., Eq. 5, with the kinetic parameter  defined as

 

[Eq. 7]         

 

where  and  are  row and column vector, respectively, whose ith element is 

the composition difference  as described in Eq. 6. , a  
matrix, is based on thermodynamic factor matrix  with a correction factor

[Eq. 8]         

where thermodynamic factor matrix is defined as the secondary derivative of free energy with 
respect to composition in the matrix phase
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 is evaluated at the far-field matrix composition to consider the multicomponent Gibbs-
Thomson effect [1995Mor]. For a particle with critical nuclei size , the Gibbs-Thomson 
equation is 

[Eq. 9]         

where  is a  column vector representing the difference between the far-field matrix 
composition  and the equilibrium (tie-line) composition of the matrix phase . It has 
been found that Eq. 9  is not numerically accurate and sometimes the deviation can be quite 
significant. Therefore, a correction factor is introduced as

which then appears in Eq. 8.

 in Eq. 7 is the inverse of the chemical diffusivity matrix . In some alloy systems, 
diffusivity is strongly composition dependent, so that an effective diffusivity is necessary. A 
series of numerical simulations in comparison with DICTRA calculations indicates that a good 
approximation can be achieved if  is the arithmetic mean of the diffusivity with far-field 
matrix composition and diffusivity with equilibrium (tie-line) composition

Paraequilibrium Growth Rate Model

The paraequilbrium (Para-eq) growth rate model is only available for alloy systems 
where Fe is the major element and C is the only interstitial element, which also 
partitions into the precipitate phase. 

The intersitial elements, e.g. C, N, etc., usually have remarkably faster diffusion rate than the 
substitutional elements. Meanwhile, they are assumed to have negligible volume contribution, 
and as a result the composition variables in Eq. 6 to Eq. 9 are replaced by u-fractions when 
interstitial elements are included in the system. The paraequilbrium growth rate model is 
designed specifically to address the fast diffusion of C in Fe alloys. Based on the Simplified 
growth rate model, it holds a paraequilbrium condition [1953Hil]  at the migrating interface, in 
that, instead of assuming that all alloying elements are in equilibrium at the interface as the 
regular ortho-equilibrium condition states, only C assumes equilibrium state, while the 
substitutional elements are immobile and thus have the same compositions (u-fractions) across 
the interface. Therefore, only composition of C and its mobility appear in Eq. 6. 
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PE Automatic Growth Rate Model

The tempering of martensite in steels induces the precipitation of cementite particles. The 
growth kinetics initially follows the paraequilbrium  (abbreviated here as PE) condition due to 
the fast diffusion of interstitial C, and gradually transforms to regular Local Equilibrium (LE), i.e. 
Ortho-equilibrium (OE), condition so that substitutional elements can reach equilibrium 
partitioning at the migrating interface. The PE Automatic model enables the smooth transition 
from Paraequilibrium growth rate model to Simplified growth rate model. The rate of transition 
process is dependent on the relative differences in diffusion between C and substitutional 
elements, as well as the differences in driving force between PE and OE.

NPLE Growth Rate Model

The Non-Partitioning Local Equilibrium (NPLE) growth rate model is only available 
for alloy systems where Fe is the major element and at least one interstitial 
element partitions into the precipitate phase.

The NPLE growth model is designed specially to deal with the fast diffusion of interstitial 
element (C, N, etc.) in Fe alloys. Based on the Simplified growth model, it still holds a local 
equilibrium condition at the migrating interface, but chooses a tie-line under NPLE condition 
[1958Kir]  that the u-fractions of all substitutional elements and minor interstitial elements in 
the precipitate phase are the same as those in the far-field matrix phase (i.e. the overall 
instantaneous matrix composition).

Model Selections

The most efficient model is the Simplified model, which is the default and applicable to most 
alloy systems under conditions that either the supersaturation is small, or the alloying elements 
have comparable diffusivity. If all alloying elements are substitutional but they have remarkable 
diffusivity difference, e.g. in Al-Zr system, or the diffusivity is strongly composition dependent, 
the General model is preferred. If the supersaturation is high, and meanwhile there are fast-
diffusing interstitial elements such as C, the Advanced model is more appropriate to capture 
the NPLE mechanism.
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In some cases with the General model, you may need to switch to another model 
if the matrix composition passes through a spinodal composition space where the 
thermodynamic factor becomes negative, thus leading to an abnormal growth 
rate. When this happens, Thermo-Calc alerts you that the Matrix Composition in 
Spinodal Zone. It is then recommended to switch to other models.  

Non-Zero Volume Correction

The non-zero volume correction to the velocity according to Chen and Voorhees [1993Che]  is 
taken into account and it follows as 

[Eq. 10]         

where 

 l is the corrected velocity

 l  is the mean radius 

 l  is the number density

Non-Spherical Particles

A reference for this section can be found in [2018Wu].

Particle Shape Determination

The shape of the cuboid particles, the cubic factor, is determined by the minimization of 
combined interfacial energy and elastic strain energy. If you choose Calculated from molar 
volume for the Transformation strain as the Precipitation Calculator → Precipitate Phase 
settings, the lattice misfit is then calculated from difference in molar volume between matrix 
and precipitate phase, and the elastic strain energy is calculated accordingly. If you disregard 
the transformation strain, the elastic strain energy is neglected and hence the particles remain 
spherical in shape. 

If you select the Calculated aspect ratio from elastic energy checkbox for either a plate or 
needle Morphology on the Precipitation Calculator → Precipitate Phase settings, the particle 
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shape is determined by the minimization of combined interfacial energy and elastic strain 
energy. Otherwise, if you enter a value for aspect ratio, the particle shape is fixed except for 
nucleation calculation in which a spherical particle is always assumed. 

"Homogeneous Nucleation" on page 69

Interfacial Energy Anisotropy

"Precipitation Morphology" on page 102

Isotropic interfacial energy is always assumed for spherical and cuboidal particles. For plate and 
needle, when the aspect ratio becomes larger than 1, the interfacial energy anisotropy occurs, 
so that the interfacial energy at the edge is larger than that at the broad face (habit plane). This 
increases the overall interfacial energy which is given as follows for each morphology.

Plate

Needle

Where

 l  is the aspect ratio

 l  is the interfacial energy of the habit plane, i.e., the plane normal to the shorter axis

 l  is the radius of a sphere with equivalent volume

Growth Rate Adjustment

"Precipitation Morphology" on page 102

For non-spherical particles, the growth rate equations for spherical particles are still applicable, 
but adjustment parameters are introduced to take into account the shape effect. The cuboid 
particles arise from "symmetry preserving" transformation, e.g., FCC_A1 to L12 , and are thus 
highly isotropic and assumed growth rate equal to that of spherical particles. The plate and 
needle particles, on the other hand, arise from "symmetry breaking" transformations, e.g., 
cubic to tetragonal transformation, and are thus anisotropic leading to a significant increase of 
growth rate. 
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We define  as the radius of a sphere with equivalent volume of the non-spherical particle, so 
that the format of Eq. 5 keeps unchanged. In our current model, two effects are considered 
contributing to the growth rate for plate and needle particles, from interfacial energy 
anisotropy and particle shape effect. The kinetic parameter  defined in Eq. 5 is thus given as

[Eq. 11]         

with  defined in Eq. 6 and Eq. 7. The interfacial energy  in Eq. 5 is that of habit plane, i.e., 
the plane that is normal to the shorter axis of the particle.  is the parameter that takes into 
account the Gibbs-Thomson effect due to interfacial energy anisotropy, based on Johnson 
[1965Joh].

Plate

 

Needle

where  is the aspect ratio of the ellipsoidal particle.  is the parameter that takes into 
account the non-spherical concentration field around the particle. Assuming a shape-conserving 
concentration field and thus following the derivation by Ham [1958 and 1959], it is given as

Plate

Needle

where  is the eccentricity of the ellipsoidal particle.
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Coarsening

Physically speaking, coarsening or Ostwald ripening where big particles grow and small particles 
shrink is a process driven by lowering the total surface energy of the system. From a 
thermodynamic point of view, the Gibbs-Thomson effect leads to inhomogeneous chemical 
potentials in the system if the particle sizes are not uniform. Solutes at the interface in the 
matrix near a particle of a radius smaller than critical radius have a higher chemical potential 
than that corresponding to the mean concentration of the matrix. As a result, the solutes 
diffuse from the precipitate/matrix interface to the inside of the matrix and cause dissolution of 
the particle. Conversely, particles with a radius larger than the critical size have lower interface 
potentials, and the solutes diffuse to the interface and cause growth of the particles.

Since it is not possible to find a closed form analytic solution for the problem of diffusion-
controlled spherical particle dissolution [1970Aar], we simply apply the Growth equations 1 to 5 
with the absolute value of  to calculate the interface velocity for particles of all sizes. 

As can be easily seen, if  , then the Gibbs-Thomson Equation 1  gives , and a 
negative velocity results from Equation 2 for particles having   , which means that they 
shrink. 

Results for particles having are obtained vice versa. In all situations, when the absolute 
values of   are very small, the steady-state solution for either growth or dissolution are 
recovered. In conclusion, the dissolution is treated as the reverse of growth (1970Aar, Ibid.),  
and the coarsening comes out naturally either together with nucleation and growth or as a 
dominant process finally in the course of the evolution of the PSD. 
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Continuity Equation

Let  be the PSD of a precipitate phase,  the number of particles per unit volume,   the 
mean radius and  the particle volume fraction, is expressed as 

[Eq. 1]         

[Eq. 2]         

[Eq. 3]         

The time evolution of  follows the continuity as in Langer and Schwartz [1980Lan].

[Eq. 4]         

Where   is the growth rate of a particle of size , and  is the distributed nucleation rate, 
which is defined by 

[Eq. 5]         

where  is the nucleation rate.
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Mass Conservation

The matrix concentration is updated at each time step according to the law of mass 
conservation. If the alloy concentration, i.e. initial mole fraction of component  in the matrix 
phase is , the new concentration  can be obtained from the following mass balance shown 
in

where 

 l  is the mole fraction of element  at the interface in the precipitate phase   of 
particle size  at time .  ,  and    are the PSD function, growth rate, and 
molar volume of the precipitate phase , respectively.

 l   is the time at time step . 

Apparently, the new matrix concentration, and thus the updated supersaturation, nucleation 
rate, and interface velocity are all functions of the PSD function. This inevitably leads to the 
complex non-linear behavior of and great difficulty in solving the continuity equation.
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Numerical Method

Since it is impossible to have a general close form solution, the complex non-linear continuity 
equation (see "Continuity Equation" on page 94) of the particle size distribution (PSD) function 
has to be solved numerically. Different numerical methods can be found in the literature to 
solve this equation, such as finite difference and method of characteristics. In all approaches, 
the continuous PSD is discretized into a sufficiently large number of size classes, and then 
integrated discretely in the time space.  The Precipitation Module utilizes the method of 
characteristics, where the number of particles in each size class is kept constant unless particles 
of the same size have been nucleated.   

An adaptive geometric grid allocation method has been used for particle size discretization 
since from nucleation to coarsening the particle size can span several orders of magnitude. In 
this approach, the new size grids are allocated evenly in a logarithmic scale and the number of 
grid points over one order of magnitude is kept almost constant during the whole process by 
class merging and splitting. The time step is controlled by several adjustable numerical 
parameters based on mechanistic quantities. 

Summarized below are all numerical parameters used in this approach to control either the size 
grid distribution or time steps. 

Maximum Time Step Fraction

Maximum time step allowed for time integration as fraction of the simulation time.

Number of Grid Points Over One Order of Magnitude in r

Default number of grid points for every order of magnitude in size space. The number 
determines a default ratio between two adjacent grid points. When there is a need to create 
new grid points, such as nucleating at a new radius not covered by the current range of PSD, 
this default ratio is used to add these new radius grid points. A larger value of this parameter 
enforces a finer grid to allow better numerical accuracy. However, this also comes with 
performance penalty, since finer grid in the size space often requires smaller time step to 
resolve the calculations. 
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Maximum Number of Grid Points Over One Order of Magnitude in r

The maximum allowed number of grid points in size space. This parameter determines a lower 
bound limitation for the ratio of every two next nearest grid points in order to maintain 
adequate computational efficiency. When a ratio of two next nearest grid points is less than 
this limit, the middle grid point is removed and the corresponding size class merged with the 
two neighboring ones. 

Minimum Number of Grid Points Over One Order of Magnitude in r

The minimum allowed number of grid points in size space. This parameter determines an upper 
bound limitation for the ratio of every two adjacent grid points in order to maintain proper 
numerical accuracy. When a ratio of two adjacent grid points exceeds this limit, a new grid 
point is then inserted between the two adjacent grids to keep the required resolution.

Maximum Relative Radius Change 

The maximum value allowed for relative radius change in one time step. This parameter limits 
the time step according to the following relation, which is controlled by the particle growth:

 for 

where  is a cut-off subcritical size defined by the next parameter. The growth rates of 
supercritical particles (with  ) are always bounded, and there is a size class and the 
corresponding growth rate that controls the time step. The subcritical particles (with ), 
however, has a mathematical singularity (negative infinity) in growth rate as  approaches 0. 
This means that the time step can become extremely small if applying the above criterion to 
very small subcritical particles. In open literature, several researchers have tried mathematical 
transformation to avoid this singularity. Unfortunately, the transformation also complicates the 
formulation of the models. The Precipitation Module implementation uses a simple approach 
to deal with this issue by defining a cut-off size . All the particles with  may disappear 
within one time step.  is determined by the next input parameter.
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Maximum Relative Volume Fraction of Subcritical Particles Allowed to 
Dissolve in One Time Step

This parameter represents the portion of the volume fraction that can be ignored when 
determining the time step. It is used to calculate the cut-off subcritical size, , for the above 
time step control that allows a maximum relative radius changes for all particles: 

Relative Radius Change for Avoiding Class Collision

For the supercritical particles, the growth rate is non-linear – usually, it first increases with  
and then decreases after a certain size. In the region(s) with growth rate decreasing with , it is 
possible that the smaller size grid point can catch up with the larger size grid, if the time step is 
not controlled. To prevent this from happening, an additional parameter, , can be used to set 
a limit on time step according to the following relation: 

for 

and

Maximum Overall Volume Change 

This parameter defines the maximum absolute (not ratio) change of the volume fraction 
allowed during one time step. This parameter is also used in controlling allowable variation in 
volume fraction due to the newly created particles within one time step. That is 

where  and  are effective radius and nucleation rate, respectively.
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Maximum Relative Change of Nucleation Rate in Logarithmic Scale 

This parameter ensures accuracy for the evolution of effective nucleation rate. It sets a limit on 
time step so that the relative change of nucleation rate does not exceed the specified value, 
based on the information of previous step. That is 

where nucleation rate   and  occurs at the beginning and end of .

Maximum Relative Change of Critical Radius

During the nucleation under high supersaturation, the critical radius can vary dramatically. 
Hence, this parameter can be used to place a constraint on how fast the critical radium can 
vary, and thus put a limit on time step: 

Minimum Radius for a Nucleus to be Considered as a Particle

The cut-off lower limit of precipitate radius. Particles with radius smaller than the value 
specified for this parameter are discarded. In reality, the particle cannot be smaller than an 
atom; hence, there is no reason to keep track of particles of unphysical sizes.

Maximum Time Step During Heating Stages

The upper limit of the time step that has been enforced in the heating stages. The current 
algorithm may over-estimate the subsequent time increment when temperature is increased. It 
is thus required to reduce this value when the calculation terminates unexpectedly during or 
after a heating stage. 

Numerical Control Parameters Default Values

Default value for numerical parameters that controls the size grid distribution and time step.
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Parameter Default value

0.1

200

300

100

0.01

0.01

0.5

0.001

0.5

0.1

5e-10m

1.0s
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Estimation of Coherent Interfacial Energy

Interfacial energy is an important parameter used in precipitation simulations to calculate the 
rates of nucleation, growth/dissolution, and coarsening. The value of interfacial energy can vary 
dramatically (usually between 0.01 to 2.0 J/m2).

The extended Becker’s model functions to estimate coherent interfacial energy by using 
thermodynamic data from existing CALPHAD thermodynamic databases: 

where  is the coherent interfacial energy,  is the number of atoms per unit area at the 
interface,  is the number of cross bonds per atom at the interface,  is the coordination 
number of an atom within the bulk crystal lattice, and  is the energy of solution in a 
multicomponent system involving the two phases being considered [1938Bec].

Reference
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"Interfacial Energy Anisotropy" on page 90
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Precipitation Morphology

As the spherical particle is the default morphology, for precipitations within the grain, three 
non-spherical shapes are considered: cuboid, plate and needle.

"Growth" on page 83

"Homogeneous Nucleation" on page 69

"Precipitate Phase Settings" on page 29

Cuboid

Figure 11: Cuboids have six faces, which form a convex polyhedron.

The cuboid shape is described by a supersphere

with p=2 being spherical shape. The larger the p, the more cubic the shape. Sometimes it is 
useful to define the cubical character as

Which gives a spherical shape when  , and a cubic shape when . 
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Plate

Figure 12: Oblate spheroids have rotational symmetry around an axis from pole to pole.

The plate is described as oblate spheroid

with aspect ratio

Needle

Figure 13: A prolate spheroid is a surface of revolution obtained by rotating an ellipse about its major 
axis.

The needle shape is described as prolate spheroid

with aspect ratio
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Precipitations at a Grain Boundary, Edge or Corner

For precipitations at a grain boundary, grain edge, or grain corner, non-spherical particles are 
considered based on wetting angle. 

"Heterogeneous Nucleation" on page 76

"Matrix Phase Settings" on page 22



Precipitation Module (TC-PRISMA) User Guide

Theoretical Models and Numerical Methods  ǀ 105 of 224

Normal Grain Growth

The normal grain growth model in the Precipitation Module (TC-PRISMA) uses a similar 
approach to its precipitation counterpart (see "Theory Overview" on page 66) in that it 
calculates the temporal evolution of grain size distribution (GSD). The grains are assumed of 
spherical morphology when modeling the growth rates. Nucleation is not considered, thus an 
initial GSD is necessary to start the simulation.

The boundary motion of a grain with radius  without considering pinning forces from 
precipitate particles, is driven by curvature and can be modeled as [1957Fel; 1965Hil]

[Eq. 1]          

where

 l  is grain boundary mobility ( )

 l  is the grain boundary energy ( )

 l  is a dimensionless constant

If it should be satisfied that , which is the parabolic growth rate of average grain size at 
steady-state

[Eq. 2]         

It was found that  [1965Hil].

 in Eq. 1 is the critical grain size, which, not necessarily the average grain size, is determined 
by volume conservation [2008Jep]

[Eq. 3]          

where the index  covers all the grains at each time step. Substituting Eq. 1 into Eq. 3,  is 
obtained at each time step.

Grain Boundary Mobility Values

The grain boundary mobility  can be calculated as:

[Eq. 4]         

where
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 l  is the prefactor (m4/Js)
 l  is the activation energy (J/mol)

The recommended values of  and  in high purity metals such as ferritic iron, austenitic iron, 
nickel, and aluminum are shown in the table below.

Since grain growth is significantly affected by grain boundary segregation, 
precipitation, and grain boundary complexion, the accuracy of the mobility data 
used for the recommended values is not guaranteed.

If the grain size is in nanoscale, these parameters may not be applicable since the 
effects of grain boundary junction and complexion cannot be ignored in 
nanocrystals. For some alloys, such as Al, the parameters can also be sensitive to 
temperature. The temperature range in the table is the suggested best fit.

Recommended grain growth parameters for mobility prefactor  and activation energy .

 
Matrix 
Phase

Temperature 
Range (K)

Prefactor M0 
(m4/Js)

Activation 
Energy Q (J/mol)

Reference

High purity iron BCC_A2 625 ~ 875 4E-3 242000 [1997Mal]

Low alloying 
steel (Cr-Mo)

FCC_A1 1173 ~ 1473 3.6E-3 228302 [2008Lee]

Pure Ni
DIS_FCC_
A1/FCC_L12

1098 ~ 1323 4.12E-8 123050 [2008Ran]

High purity 
aluminum

FCC_A1

300 ~ 548 1.02E-14 27430

[2004Yu]

573 ~ 773 1.25E-8 73080
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Zener Pinning
Zener [1948Smi] proposed a pinning force due to second-phase particles, so that the normal 
grain growth would be completely inhibited when the grain size reached a critical maximum 
grain size . In general form, it can be expressed as [1998Man]

[Eq. 1]         

Where

 l  is the radius of the pinning particles

 l  the volume fraction of the particles

 l  is a dimensionless constant

 l  an exponential index for 

The original Zener pinning theory gives

which has been found to be inconsistent with the experimental information and thus needs 
refinement.

For simplicity, the average particle radius  of a precipitate phase  has been used to calculate 
the pinning force arising from all the particles of this phase. The pinning force, , can be 
evaluated as the inverse of 
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When there are multiple precipitate phases, the overall pinning effect is the sum of that from 
all precipitate particles,

The retarding force due to Zener pinning, , is therefore [1965Hil]

where  is the grain boundary energy.

Realizing that the drag force resists the grain boundary motion, no matter in the growing 
(positive velocity) or shrinking (negative velocity) direction, the overall growth rate is expressed 
as [1965Hil]

The negative sign holds when

while positive sign holds when

And  when  lies between these two limits.

In the Precipitation Module (TC-PRISMA), you can input parameters      and  for each 
precipitate phase. An additional parameter, cutoff radius (unit= m), can be used so that 
precipitates with a smaller size than this value are excluded from the calculation of pinning 
force. This adjustment avoids an unreasonably large pinning force calculated from very small 
precipitates (e.g. nuclei).

"P_14: Grain Growth and the Zener Pinning Effect" on page 209
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Stereology

Stereology is the science of assessing the three-dimensional (3D) geometry and morphology of 
objects utilizing data descriptive of a cross-section of the material. It is common to characterize 
a precipitate dispersion utilizing quantitative image analysis of micrographs obtained from light 
or scanning electron microscopy. In these cases, the data describes the precipitates found in a 
cross-section taken through the sample.

Figure 14: a) A 3D dispersion of non-penetrating polydisperse particles. b) A cross-section taken 
through the dispersion.

Stereological considerations are important when seeking greater quantitative accuracy 
comparing model calculations and experimental data. The two-dimensional (2D) size 
distribution is of interest for the calculation of mechanical properties as it represents the size 
distribution of obstacles encountered by a dislocation on a slip system.

The size of the precipitates can be expressed as the equivalent radius of a circle with the same 
cross-sectional area as measured from the micrograph. Figure 15, Figure 16, and Figure 17 
compare the 3D and 2D size distributions of a spherical dispersion considering a left skewed, a 
normal, and a right-skewed distribution. Observe the changes in shape of the distribution in 
addition to the smaller 2D mean radius compared to the true 3D size.

The 3D to 2D conversion implementation considers spherical particles. Although 
the precipitates may be approximated as spherical for the approximation of the 2D 
size distribution, there may be a large error for geometries that differ largely from 
spheres.
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The 3D → 2D checkbox that is available to use this feature requires (1) that the 
Precipitate Phase Morphology is set to Sphere on the Precipitation Calculator, and 
then (2) one of these axis variables is selected on either the Plot or Table 
Renderer: Mean radius, Size distribution, Number density distribution, or 
Normalized number density distribution.

Figure 15: A comparison of the 3D and 2D particle size distributions considering a left-hand skewed 
Weibull distribution.
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Figure 16: A comparison of the 3D and 2D particle size distributions considering  a normal distribution
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Figure 17: A comparison of the 3D and 2D particle size distributions considering  a right-hand skewed 
log-normal distribution.

Analytical solutions exist for the determination of the 2D size distribution of impenetrable 
polydisperse spheres [1958Sal; 1925Wic]. Thermo-Calc has implemented the Jeppsson-
Mannesson-Borgenstam-Agren (JMBA) [2011Jep] Saltykov conversion method to calculate the 
2D size distribution.

Let  describe the number of particles with radius varying between  and  within a 
unit volume. The corresponding 2D size distribution is given by , describing the number 
of particle cross-sections with a radius varying between  and  within a unit area. 
Following the Saltykov method, the 2D size distribution is obtained from the following matrix 
calculation:

where  is a matrix of probabilities for the conversion and  describe the likelihood of 
obtaining a 2D cross-section of radius  from 3D grains of radius  .  The JMBA model derived 
these probabilities as:
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Where  and  describe the lower and upper boundaries to the particle radii class .  and 
 are the spacing between radii midpoints and class boundaries, respectively. For a linear 

discretization, .

It is assumed that the 2D cross-section is a perfect cut through the material however there may 
be some error in this approximation. Figure 18 presents the idealized case with a 3D and 2D 
size distribution with a mean radius of 1.5 µm. In Figure 19, it is assumed that the minimum size 
of particles that can be quantified in the micrograph is 0.25 µm. This crops off the left-hand tail 
of the 2D distribution. Etching away the matrix reveals sub-surface particles. Figure 20 shows 
the impact of etching a depth of 30 nm, further exposing particles that have a center below the 
cross-section of the cut.

Figure 18: Potential causes of error in micrographs showing the idealized 2D size distribution. 
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Figure 19: Potential causes of error in micrographs showing the cropped left-hand tail caused by a 
limiting size that can be measured from the micrograph. 
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Figure 20: Potential causes of error in micrographs showing how the left-hand tail can be blurred due 
to etching.
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Precipitation Module (TC-PRISMA) Examples 
Collection

Examples that use up to three elements are available to all users. Other examples 
require a Precipitation Module (TC-PRISMA) license to calculate and plot results. 

When an example uses a demonstration (demo) database package, this is included 
with your installation. 

Unless specified in tables for each example, all the numerical parameters are 
assumed default values.

In this section:

P_01: Isothermal Precipitation of Al3Sc 122

PDF Tutorial for P_01-Isothermal 127

P_02: Stable and Metastable Carbides - Isothermal 136

P_03: Stable and Metastable Carbides - TTT Diagram 140

P_04: Precipitation of Iron Carbon Cementite 144

P_05: Precipitation of γ’ in Ni Superalloys - Isothermal 147

P_06: Precipitation of γ’ in Ni Superalloys - Non-isothermal 152

P_07: Continuous Cooling Transformation (CCT) Diagram of Ni-Al-Cr γ-γ’ 159

PDF Tutorial for P_07-CCT 163

P_08: Precipitation of Cu-Ti CU4TI with Assumptions of Sphere and Needle Morphologies168

P_09: Precipitation of Al-Sc AL3SC with Assumption of Sphere and Cuboid Morphologies 175

PDF Tutorial for P_09-Al-Sc-Sphere_Cuboid 181
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P_12: Comparing Growth Rate Models for an Al-Zr System 201
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P_14: Grain Growth and the Zener Pinning Effect 209
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P_16 Isothermal Coarsening and  a 3D to 2D Stereological Conversion 219



Precipitation Module (TC-PRISMA) User Guide

Precipitation Module (TC-PRISMA) Examples Collection  ǀ 122 of 224

P_01: Isothermal Precipitation of Al3Sc
This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase. 
The simulation results can be compared with experimental data collected from Marquis and 
Seidman [2001Mar] and Novotny and Ardell [2001Nov].

This example also includes a plot using the Yield strength Property Model. This demonstrates 
how you can use the results from a Precipitation Module (TC-PRISMA) simulation as input to 
the Yield Strength Model, i.e. the calculated precipitate radius/radii for each time step is used 
to calculate the precipitation strengthening, and similarly, the matrix composition for each time 
step is used to calculate the solid solution strengthening when this is selected in the 
Configuration on the Plot Renderer. The experimental data for the Yield Strength Model is from 
Seidman et al. [2002Sei]. In this example, the Precipitation strengthening model used is 
Seidman model (Al-base). This is selected on the Plot Renderer configuration panel that is 
connected to the Property Model.

Project File and Step-By Step Instructions

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_01_Precipitation_Al-Sc_AL3SC.tcu

You can also use the step-by-step instructions included in a PDF to follow the video 
or compare to the project file in Thermo-Calc.

Example Settings

System (System Definer)

Database package
Demo: Aluminum-based 
alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Conditions (Precipitation Calculator)

Composition Al-0.18Sc Mole percent

Matrix phase FCC_A1

Tutorial-P_01-Isothermal.pdf
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Precipitate phase AL3SC

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy Calculated

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 1.0E7 seconds

Experimental File Reader 1 and 2  

There are two Experimental File Reader nodes used. One for the mean radius 
plot and one to demonstrate the Yield Strength Property Model.

 

Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our 
website and as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

https://thermocalc.com/support/video-tutorials/precipitation-module-tc-prisma-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

Figure 21: During set up of the calculation, you can preview the  Thermal Profile. Click the tab in the 
Visualizations window to  preview it and adjust settings on the Precipitation Calculator Configuration 
window. For an Isothermal Thermal Profile this shows the constant temperature as entered. 
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Figure 22: After performing the calculation, you can view the  result on the applicable tab. This plot 
shows the mean radius of the AL3SC precipitate as a function of time.

Figure 23: After performing the calculation, you can view the  result on the applicable tab. This plot 
shows the total yield strength of the AL3SC precipitate as a function of time compared to 
experimental data from Siedmen et al. [2002Sei]. The model captures the over-tempering behavior 
from excessive coarsening of the strengthening precipitates.
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Isothermal Precipitation Calculation: Example P_01 – 
Precipitation Al-Sc AL3SC 

This example shows you how to set up an isothermal precipitation calculation for the formation of 
AL3SC in an aluminium-scandium alloy at 350° using the Precipitation Module (TC-PRISMA).  

The end of the example also shows how to use the results of the calculation to model Yield Strength.  

This is one of the most basic calculations using the Precipitation Module (TC-PRISMA), so it is a good 
place to start if you are new to this simulation type.  

HELPFUL INFORMATION 

• All users can run this calculation, even those who do not have a license for the Precipitation 
Module (TC-PRISMA).  

• A companion video is available for this example , which can be watched here:  
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ 

This calculation is based on Precipitation Module example P_01 – Precipitation Al-Sc AL3SC, which is 
included in your installation.  

1. To run the example file, open Thermo-Calc and select Help > Examples Files or click Example 
Files on the My Project Configuration window.  

2. Open the Precipitation Module (TC-PRISMA) folder. Double-click the example file to open it. 
3. In Thermo-Calc at the bottom center of the Configuration window click Perform Tree.  

 

 

https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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ABOUT THE EXAMPLE  

This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase. The 
results of the simulation are also used to model yield strength.  

SETTING UP THE SYSTEM 

1. Open Thermo-Calc in Graphical Mode.  
2. On the My Project Configuration window under Non-Equilibrium, click Precipitation. 
3. All the nodes for a precipitation calculation are added to the Project window:  

 

4. In the Project window, click the System Definer 1 node.  
5. On the Configuration window from the Package list, select Demo: Aluminium-based alloys 

(ALDEMO, MALDEMO). This loads both thermodynamic and kinetic demonstration 
aluminium databases.  

6. In the Periodic Table, select the elements in the following order.  
Select Al first so that it is the dependant element: 

a. Al (aluminium)  
b. Sc (scandium).  

7. From the Amount list (to the right of the Periodic Table), select Mole percent. 
8. Enter 0.18 for Sc. This automatically sets Al to 99.82.  
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The system is now defined. However, before starting the precipitation calculation, it is recommended 
to run a one axis calculation to find the phases present around 350° C.  

ONE AXIS CALCULATION 

Why We Do This 

In order to set up an isothermal precipitation calculation, you need to know which phases are 
present at 350 °C. A one axis calculation provides this information. Note that this step is not included 
with the P_01 example. This is an additional exercise. 

Setting up a One Axis Calculation 

1. In the Project window, right-click the System Definer 1 node, and select Create New 
Successor > Equilibrium Calculator.  

2. In the Configuration window, set Temperature to Celsius and enter 300. 
3. Under Calculation Type, click One axis.  

You now want to find the phases present around 350 °C. 
4. Under Axis Definitions, enter the Temperature range from Min 300 to Max 700.  

Keep the default values for everything else. The system is now defined. 
5. Right-click the Equilibrium Calculator node and select Create New Successor > Plot 

Renderer.  
6. In the Project window, click the Plot Renderer 2 node you just created. In the Configuration 

window, set the X-axis variable for Temperature to Celsius. Then right-click the Plot 
Renderer 2 node select Perform Now. Or click Perform at the bottom of the Configuration 
window. 
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Interpreting the Results of the One Axis Calculation 

Once the calculation is complete, a plot is displayed in the Results window. This plot shows you 
which phases are present at each temperature between 300° and 700° and the amount of that phase 
at each temperature. 

If you hover your cursor over any of the lines on the plot, a label gives you the name of the phase, 
the temperature and the amount of the phase at that temperature.   

We can see that there are two phases present at 350°. FCC_A1 is at the very top of the plot and 
makes up more than 99% of the system. The remainder of the system is made up of Al3SC, which is 
near the very bottom of the plot and is the precipitate phase in the alloy we are considering.  

Remember these two phases because these are used in the precipitation calculation.  

 



Isothermal Precipitation Calculation 
Example P_01 – Precipitation Al-Sc AL3SC 

 

Page 5 of 9 
Version 4 (May 2022) 

 

PRECIPITATION CALCULATION 

Setting up the Precipitation Calculation 

1. In the Project window, click the Precipitation Calculator 1 node.  
2. Notice that the Composition set in the System Definer auto-populated here.  
3. Under Matrix Phase, the Phase defaults to FCC_A1, which is the primary phase present in the 

one axis calculation.  

NOTE: If you do not see any phases listed here it is probably because you do not have a kinetic 
database selected. If so, go back to the System Definer and add a kinetic (mobility) database. In this 
example it should be the MALDEMO database. 

4. Under Precipitate Phase, select AL3SC from the Phase list because that is the other phase 
present around 350 °C, as shown in the one axis calculation.  

5. Accept the rest of the default settings in the Precipitate Phase section. You could choose to 
define your own interfacial energy settings if you have them.  

6. Under Calculation Type, make sure Isothermal is selected.  
7. Enter: 

a. 350 as the Temperature and select Celsius.  
b. 1.0E7 as the Simulation time and select Seconds, which is ten million seconds.  

 

8. In the Project window, click the Plot Renderer 1 node. 
9. Under Y-axes, from the Axis type menu select Logarithmic 10 for a better view of the plot. 
10. Click Perform at the bottom, center of the Configuration window.  
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Interpreting the Results of the Precipitation Calculation 

Once the calculation is complete, your plot is shown in the Results window. 

   

At the beginning, which is the left-most side of the plot, the mean radius is quite small and then 
grows rapidly over time, which is represented by moving rightward on the plot.  

Setting Other Variables in the Precipitation Module (TC-PRISMA) 

The Precipitation Module (TC-PRISMA) offers many variables that you can plot for the same 
calculation.  

1. Click the Plot Renderer 1 node. 
2.  Under Y-axes, click the Axis variable menu to see the other available options in the list.  

This plot shows the 
Mean radius of the 
AL3SC precipitate as a 
function of time.  
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3. Once you have made your selection, click Perform at the bottom, center of the Configuration 
window to create a new plot.   

 

Model Yield Strength 

Beginning with Thermo-Calc 2020b, results of a precipitation simulation can be used as input to 
model yield strength using the Yield Strength Property Model. The following simulation requires a 
license for Thermo-Calc 2020b or newer.  

1. Right click the Precipitation Calculator 1 node and select Create New Successor > Plot 
Renderer.  

2. Under Y-axes, from the Axis variable menu, select Yield strength (as in the figure above but 
for Plot Renderer 3). 

3. Click the Configuration panel button.  
4. If required, expand the Plot Renderer Configuration window. Then from the Precipitation 

strengthening model menu select Seidman model (Al-base).  
5. Under Y-axes, from the Axis type menu, select Logarithmic 10. 
6. Click Perform at the bottom, center of the program.  

The program uses the results from the precipitation simulation as the input for the Yield Strength 
model. 
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Interpreting the Results of the Yield Strength Model 

Once the calculation is complete, your plot is shown in the Results window. 
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This plot shows the 
yield strength of the 
AL3SC precipitate as a 
function of time.  
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P_02: Stable and Metastable Carbides - Isothermal

This example simulates the kinetics of precipitation of both stable and metastable carbides 
from ferrite phase. It demonstrates that metastable carbides (cementite, M7C3) may first 
emerge and then disappear and the stable phase (M23C6) prevails. 

This example uses the Equilibrium Calculator  and a one axis calculation to determine how the 
phases change with temperature. We are interested in the carbide precipitation at 1053 K 
where only the carbide M23C6 is stable according to the equilibrium calculation. The 
Precipitation Calculator is used to do an isothermal calculation of the three phases (cementite, 
M23C6, and M7C3) where cementite and M7C3 are metastable phases. 

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_02_Precipitation_Fe-C-Cr_Cementite-M7C3-M23C6.tcu

Example Settings

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO,MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)

Grain size (click Show Details to display this 
setting)

1.0E-4 m

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Grain boundaries
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Interfacial energy
Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282 
J/m2

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 1053 K

Simulation time 400 000 seconds

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.

Figure 24: After performing the calculation, you can view the  result on the applicable tab. This shows 
the equilibrium property diagram for the Fe-C-Cr alloy, highlighting what phases are predicted to be 
at equilibrium for a range of temperatures. The calculation shows that at 1053 K, M23C6 is the stable 
carbide.
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Figure 25: After performing the calculation, you can view the  result on the applicable tab. This shows 
the evolution of the volume fraction of cementite, M7C3, and M23C6 during an isothermal heat 
treatment of an Fe-C-Cr alloy at 1073 K. The cementite and M7C3 are metastable at this 
temperature, however their nucleation kinetics are faster than the stable phase, allowing them to 
form and then dissolve when the next more thermodynamically stable phase nucleates.
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P_03: Stable and Metastable Carbides - TTT 
Diagram

In this example, the kinetics of precipitation of both stable and metastable carbides is 
calculated from the ferrite phase. It demonstrates that metastable carbides may first emerge 
and then disappear and the stable phase prevails.

This example uses the Equilibrium Calculator  and a one axis calculation type to determine how 
the phases change with temperature. Using this result,  the Precipitation Calculator is used to do 
a TTT (Time-Temperature-Transformation) diagram calculation of the three phases (cementite, 
M23C6 and M7C3) at the grain boundaries.

For a TTT diagram calculation, select TTT diagram in Calculation Type, then enter Min, Max, 
and Step of Tempeature, as well as Max annealing time. In Stop criterion, choose Volume 
fraction of phase and enter the value. 

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_03_Precipitation_Fe-C-Cr_TTT_Cementite-M7C3-M23C6.tcu

Example Settings

System (System Definer)

Database package
Demo: Steels and Fe-alloys (FEDEMO and 
MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase BCC_A2
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Precipitate phases Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)

Grain size  (click Show Details to display this setting) 1.0E-4 m

Precipitate Phase Data Parameters

Nucleation sites Grain boundaries

Interfacial energy
Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 
0.282 J/m2

Calculation Type (Precipitation Calculator)

Calculation type TTT diagram

Temperature 500° to 800° C with 25° C steps

Max. annealing time 1.0E8 seconds

Stop criteria Volume fraction of phase is set to 0.0001

Options > Numerical Parameters

No. of grid points over one order of magnitude in 
radius

150

Max no. of grid points over one order of magnitude 
in radius

200

Min no. of grid points over one order of magnitude in 
radius

100

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.
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Figure 26: After performing the calculation, you can view the result on the applicable tab. Here the 
results from the equilibrium calculator are shown, which assesses the stability of phases across the 
temperature range of interest.

Figure 27: After performing the calculation, you can view the  result on the applicable tab.This shows 
results from a TTT (Temperature-Transformation) simulation using the Precipitation Calculator to 
examine the sequence of phase transitions considering the formation of cementite, M7C3, and 
M23C6 carbide phases. The previous Equilibrium Calculator reveals the temperatures where the 
cementite and M7C3 are metastable.
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P_04: Precipitation of Iron Carbon Cementite

This example is based on  [1949Wer] and simulates the kinetics of precipitation of carbides from 
a BCC Fe solution phase. This isothermal calculation example uses the Precipitation Calculator 
plus two Experimental File Reader activities to plot the volume fraction  of the  cementite phase.

Project File  Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_04_Precipitation_Fe-C_Cemetite.tcu

Example Settings

System (System Definer)

Database package
Demo: Steels and Fe-alloys (FEDEMO and 
MFEDEMO) 

Elements Fe, C

Conditions (Precipitation Calculator)

Composition Fe-0.016C mass percent

Matrix phase BCC_A2

Precipitate phase Cementite

Matrix Phase Data Parameters (Precipitation Calculator)

Grain aspect ratio   (click Show Details to display this 
setting)

1.0

Dislocation density    (click Show Details to display this 
setting)

1.5e11m-3

Precipitate Phase Parameters (Precipitation Calculator)

Nucleation sites Dislocations

Interfacial energy 0.24 J/m2
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Growth rate model (click Show Details) Advanced 

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 102° C

Simulation time 600 000 seconds

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

When you run (Perform) this example, it takes a few minutes for the calculations 
to complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.

Figure 28: After performing the calculation, you can view the  result on the applicable tab. The result 
compares the predicted evolution of the volume fraction of cementite with the measurements of 
[1949Wer]. 

Reference

[1949Wer] C. A. Wert, Precipitation from Solid Solutions of C and N in α-Iron. J. Appl. Phys. 20, 
943 (1949).
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P_05: Precipitation of γ’ in Ni Superalloys - 
Isothermal

This example simulates the kinetics of precipitation of gamma prime (γ’) phase from gamma (γ) 
phase. The simulation results can be compared with experimental data collected from Sudbrack 
et al. [2008Sud]. 

This example uses three Experimental File Reader activities with the Precipitation Calculator. It 
does an isothermal calculation to plot the volume fraction, mean radius, and number density of 
the  cementite phase.

DIS_FCC_A1 needs to be selected on the System Definer. See "Selecting the 
Disordered Phase as a Matrix Phase " on page 28 for details.

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_05_Precipitation_Ni-Al-Cr_Isothermal_Gamma-Gamma_prime.tcu

Example Settings

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al Cr

Conditions (Precipitation Calculator)

Composition Ni-9.8Al-8.3Cr Mole percent

Matrix phase
DIS-FCC_A1 See "Selecting the Disordered Phase as a Matrix Phase " on 
page 28
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Precipitate phase FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy 0.012 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 800° C

Simulation time 1 000 000 seconds

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.

Figure 29: After performing the calculation, you can view the result on the applicable tab. This plot 
compares the predicted evolution of the volume fraction of gamma prime with the measurements of 
[2008Sud]. 
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Figure 30: After performing the calculation, you can view the  result on the applicable tab. This plot 
compares the predicted evolution of the number density of gamma prime with the measurements of 
[2008Sud].

Figure 31: After performing the calculation, you can view the  result on the applicable tab. This plot 
compares the predicted evolution of the mean particle radius of gamma prime with the 
measurements of [2008Sud].
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Reference

[2008Sud] C. K. Sudbrack, T. D. Ziebell, R. D. Noebe, D. N. Seidman, Effects of a tungsten 
addition on the morphological evolution, spatial correlations and temporal evolution of a 
model Ni–Al–Cr superalloy. Acta Mater. 56, 448–463 (2008).
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P_06: Precipitation of γ’ in Ni Superalloys - Non-
isothermal

This example simulates the kinetics of precipitation of gamma prime (γ’) phase from gamma (γ) 
phase in Ni-8Al-8Cr and Ni-10Al-10Cr at.% alloys during continuous cooling from a super-solvus 
temperature. The simulation results can be compared with experimental results from 
Rojhirunsakool et al. [2013Roj].

DIS_FCC_A1 needs to be selected on the System Definer for both the 
thermodynamic and mobility databases. See "Selecting the Disordered Phase as a 
Matrix Phase " on page 28 for details.

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_06_Precipitation_Ni-Al-Cr_Non-isothermal_Gamma-Gamma_prime.tcu

Example Settings

System (System Definer)

Database package
Demo: Nickel-based Super Alloys (NIDEMO and 
MNIDEMO)

Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition (Ni-8Al-8Cr) Ni-8Al-8Cr Mole percent

Composition (Ni-10Al-10Cr) Ni-10Al-10Cr Mole percent

Matrix phase
DIS_FCC_A1 See "Selecting the Disordered Phase as a 
Matrix Phase " on page 28
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Precipitate phase FCC_L12#2

Matrix Phase Data Parameters (Precipitation Calculator)

Mobility adjustment > Prefactor (click Show Details 
to display this setting)

Keep the default, Same for all elements, then enter 
5.0 for the Prefactor.

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy 0.023 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Non-isothermal

Temperature unit Celsius

Time unit Seconds

Temperature

1150 - 380 °C

Simulation time (Ni-8Al-8Cr) 3300 s

Simulation time (Ni-10Al-10Cr) 3300 s

Multimodal PSD (Plot Renderer)

Separate multimodal PSD checkbox is selected for 
8Al-8Cr for both the Mean radius and PSD plots.

 l Mean Radius and PSD plots: The Inflection 
neighbors and Smoothing interactions 
defaults are kept.

 l Mean Radius plot: The Points are set to 15.

Separate multimodal PSD checkbox is selected for 
10Al-10Cr for both the Mean radius and PSD plots.

 l Mean Radius and PSD plots: The Inflection 
neighbors and Smoothing interactions 
defaults are kept.
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 l Mean Radius plot: The Points are set to 50.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

When you run (Perform) this example, it takes a few minutes for the calculations 
to complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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In this example, all nodes are renamed in the Project window, and this matches 
each of the tab names in the Visualizations window.

Figure 32: During set up of the calculation, you can preview the non-isothermal Thermal Profile(s). 
Click the tab in the Visualizations window to adjust settings on the Precipitation Calculator 
Configuration window. In this case the heat treatment is a continuous cooling curve, however any 
thermal profile can be modeled using the Non-isothermal Calculation Type.
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Figure 33: These results show the predicted evolution of the mean radius of gamma prime 
populations nucleating during the quench for the Ni-8Al-8Cr alloy. Note that the tertiary particles 
(second particle population) are very small, and this dispersion would appear monomodal without 
TEM characterization.

Figure 34: These results show the predicted evolution of the mean radius of gamma prime 
populations nucleating during the quench for the Ni-10Al-10Cr alloy. In this case three distinct 
particle populations are simulated to form, agreeing with [2013Roj].
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Figure 35: These results show the predicted size distributions of precipitates at different times during 
the quench of the for the Ni-8Al-8Cr alloy. The individual particle populations are distinguished using 
the “Separate multimodal PSD” option showing a bimodal distribution with very small nano-meter 
sized tertiary particles.

Figure 36: These results show the predicted size distributions of precipitates at different times during 
the quench for the Ni-10Al-10Cr alloy. The individual particle populations are distinguished using the 
“Separate multimodal PSD” option showing the formation of a tri-modal dispersion.
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Reference
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P_07: Continuous Cooling Transformation 
(CCT) Diagram of Ni-Al-Cr γ-γ’

This example shows you how to simulate a CCT (Continuous Cooling Transformation) diagram 
for gamma prime (γ’) precipitation in a Ni-Cr-Al alloy using the Precipitation Calculator. A CCT 
calculation maintains the same cooling rate the entire time.

The system is a Ni-10Al-10Cr γ - γ’ alloy and it is calculated and plotted with superimposition of 
the cooling rate values.

Project File and Step-By Step Instructions

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_07_Precipitation_Ni-Al-Cr_CCT_Gamma-Gamma_prime.tcu

You can also use the step-by-step instructions included in a PDF to follow the video 
or compare to the project file in Thermo-Calc.

Example Settings

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition Ni-10Al-10Cr Mole percent 

Matrix phase DIS_FCC_A1

Precipitate phase FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Tutorial-P_07-CCT.pdf
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Interfacial energy 0.023 J/m2

Calculation Type (Precipitation Calculator)

Calculation type CCT Diagram

Temperature Min to Max 500 to 1200 Kelvin

Cooling rate(s) .01 .1 1 10 100 K/s

Stop criteria Volume fraction of phase 1.0E-4

Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our 
website and as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

When you run (Perform) this example, it takes a few minutes for the calculations 
to complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

https://thermocalc.com/support/video-tutorials/precipitation-module-tc-prisma-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

Figure 37: In this plot, the blue horizontal line shows the time it takes for γ’ to transform at each of 
the cooling rates according to the stop criteria, which is set as 1e-4 volume fraction. The cooling rates 
are represented by the multicoloured curved lines.

If you hover your mouse over the intersection of the blue line and any of the vertical lines, a 
yellow box shows the approximate time it takes for γ’ to transform according to the stop 
criteria, which is a volume fraction of 1e-4, followed by the approximate temperature. 
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Figure 38: An example of the table shown in the Visualizations window, which shows the same 
information as in the plot - for each cooling rate the temperature and the time it takes for γ’ to 
transform according to the stop criteria, which is a volume fraction of 1e-4.
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Continuous Cooling Transformation (CCT) Diagram of 
Ni-Al-Cr γ-γ’: Precipitation Example P_07 

HELPFUL INFORMATION 

• All users can run this calculation, even those who do not have a license for the Precipitation 
Module (TC-PRISMA).  

• A companion video is available for this example , which can be watched here:  
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ 

• This calculation is based on Precipitation Module example P_07 – Precipitation NI-Al-
Cr_CCT_Gamma-Gamma_prime, which is included in your installation.  

1. To run the example file, open Thermo-Calc and select Help > Examples Files or click Example 
Files on the My Project Configuration window.  

2. Open the Precipitation Module (TC-PRISMA) folder. Double-click the example file to open it. 
3. In Thermo-Calc at the bottom center of the Configuration window click Perform Tree.  

 

 

ABOUT THE EXAMPLE  

This example shows you how to simulate a CCT diagram for gamma prime (γ’) precipitation in a Ni-Cr-
Al alloy using the Precipitation Module known as TC-PRISMA.  

CCT stands for Continuous Cooling Transformation and is a calculation that maintains the same 
cooling rate the entire time.  

The system is a Ni-10Al-10Cr γ - γ’ alloy and it is calculated and plotted with superimposition of the 
cooling rate values using the Precipitation Module (TC-PRISMA).  

https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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SETTING UP THE SYSTEM 

1. Open Thermo-Calc in Graphical Mode.  
2. On the My Project Configuration window under Non-Equilibrium, click Precipitation. 
3. All the nodes for a precipitation calculation are added to the Project window:  

 

4. In the Project window, click the System Definer 1 node.  
5. On the Configuration window from the Package list, select Demo: Nickel-based alloys 

(NIDEMO, MNIDEMO). This loads both thermodynamic and kinetic demonstration nickel 
databases.  

6. From the Periodic Table, select the elements in the following order.  
Select Ni first so that it is the dependant element. 

a. Ni (nickel) 
b. Al (aluminium) then 
c. Cr (chromium).  

7. From the Amount list (to the right of the Periodic Table), select Mole percent. 
8. Enter 10 for Al and 10 for Cr, which automatically sets Ni to 80 mole percent. 
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9. Click the Phases and Phase Constitution tab.  
10. Under Phases click to select both check boxes next 

to the disordered FCC phase, DIS_FCC_A1. 

 

 

 

 

The system is now defined. The next step is to set up the precipitation calculations.  

SETTING UP THE PRECIPITATION CALCULATION 

1. In the Project window, click the Precipitation Calculator 1 node.  
2. Notice that the composition set in the System Definer auto-populated here.  
3. Under Matrix Phase, from the Phase list select Dis_FCC_A1, which is the disordered FCC 

phase.  
4. Under Precipitate Phase from the Phase list scroll to select FCC_L12#2.  
5. Change the Interfacial energy to User-defined then enter 0.023 in the field.  
6. Under Calculation Type, click CCT Diagram, which stands for Continuous-Cooling-

Transformation and means that the same cooling rate is maintained throughout the 
calculation.  

7. In the fields set: 
a. Min (minimum) Temperature to 500. 
b. Max (maximum) Temperature to 1200. 
c. Keep the default Kelvin as the temperature unit. 
d. Enter several cooling rates for the calculation. The rates are separated by a space. 

Enter these values as shown: .01 .1 1 10 100.  
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e. Keep the default Stop criteria of 1E-4 volume fraction of the γ’ phase. 
8. The calculation is now set. At the bottom, center of the Configuration window click Perform 

CCT Diagram Simulation.  

 

INTERPRETING THE RESULTS OF THE PRECIPITATION CALCULATION 

 

In this plot, the blue line shows the time it takes for γ’ to transform at each of the cooling rates 
according to the stop criteria, which is set as 1e-4 volume fraction. The cooling rates are represented 
by the multi-coloured curved lines. 

In this plot, the blue, 
horizontal line shows the 
time it takes for gamma 
prime (γ’) to transform at 
each of the cooling rates 
according to the stop 
criteria, which we set as 
1e-4 volume fraction.   
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If you hover your mouse over the intersection of the blue line and any of the vertical lines, a yellow 
box shows the approximate time it takes for γ’ to transform according to the stop criteria, which is a 
volume fraction of 1e-4, followed by the approximate temperature. In the image above, you can see 
a time of 0.531268 seconds and a temperature of 1147.49 Kelvin for the cooling rate of 100.0 K/s, 
which is represented by the yellow line.  

SHOWING THE RESULTS AS A TABLE 

You can also view these results in the form of a table, which gives you more precise results.  

1. In the Project window, right-click the Precipitation Calculator 1 node and select Create New 
Successor>Table Renderer.  

2. Right-click the Table Renderer 1 node and select Perform Now.  

The table is shown in the Results window and shows the same 
information as in the plot - for each cooling rate the temperature and 
the time it takes for γ’ to transform according to the stop criteria, 
which is a volume fraction of 1e-4.  

 

 

Tip! You can also convert the plot data into a table format that 
includes all the points.  

1. On the Project window, click Plot Renderer 1. 
2. On the Configuration window, click the Table View button  
3. After clicking the button, click Perform at the bottom of the window or right-click the Plot 

Renderer 1 node and select Perform Now. 
4. View the converted data on the Results window. 
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P_08: Precipitation of Cu-Ti CU4TI with Assumptions 
of Sphere and Needle Morphologies

In this isothermal calculation example, the precipitation of Cu4Ti phase in a Cu-Ti binary alloy is 
calculated. To make a comparison, two separate simulations are performed, one assuming 
spherical morphology without elastic strain energy, and the other assuming needle morphology 
whose shape, determined by competition between interfacial energy and elastic strain energy, 
is changed during the simulation. The transformation strain is obtained from Borchers 
[1999Bor]. The results are compared with experiment results from Kampmann et al. 
[1987Kam]. 

For more details about the background theory, see "Precipitation Morphology" on 
page 102.

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_08_Precipitation_Cu-Ti_CU4TI1_Sphere_Needle.tcu

Example Settings

To ensure that the settings are done on the correct Precipitation Calculators, the 
Sphere and Needle nodes are renamed from Precipitation Calculator to match 
their morphology. The morphology is set in the Precipitate Phase section when 
you click Show Details.
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System (System Definer)

Database package Demo: Copper-based alloys (CUDEMO and MCUDEMO)

Elements Cu, Ti

Sphere and Needle Conditions (Precipitation Calculator)

Composition Cu-1.9Ti Mole percent

Matrix phase FCC_L12

Precipitate phase CU4TI1

Matrix Phase Data Parameters (Precipitation Calculator)

Mobility adjustment > 
Prefactor (click Show Details to 
display this setting)

Keep the default, Same for all elements, then enter 100 for the Prefactor.

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy The default 

Morphology  (click Show 
Details to display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the 
default. 
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For the Needle node (renamed from Precipitation Calculator), Needle is 
selected. 

Transformation strain (click 
Show Details to display this 
setting)

For the Sphere node (renamed from Precipitation Calculator), keep the 
default. 

For the Needlenode (renamed from Precipitation Calculator), User defined 
is selected. In this example, the following settings are defined:

 l ε11 and ε22 are set to 0.022

 l ε33 is set to 0.003 

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 10,000 seconds

Datasets (Experimental File Reader)

Borchers Mean radius vs Time 
and Borchers Number density 
vs Time

Data sets included with this example and imported to two Experimental 
File Readers. These data sets are used for the Mean Radius and Number 
Density plots, respectively.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured


Precipitation Module (TC-PRISMA) User Guide

Precipitation Module (TC-PRISMA) Examples Collection  ǀ 171 of 224

When you run (Perform) this example, it takes a few minutes for the calculations 
to complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

In this example, all nodes are renamed in the Project window, and this matches 
each of the tab names in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.
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Figure 39: The predicted evolution of the morphology of needle shaped precipitates, showing how the 
mean aspect ratio changes during the isothermal heat treatment.

Figure 40: The results compare the predicted evolution of the mean size of precipitates with the 
experimental data from [1987Kam], comparing the spherical and needle shaped approximations of 
the precipitate morphology. Note how the needle shape approximation is closer to the experimental 
data.
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Figure 41: These results show both the predicted final particle size distribution from the needle shape 
simulation and the predicted relationship between the length of the precipitate and the needle 
aspect ratio.

Figure 42: This shows the approximates the size of the needle shaped precipitates as a sphere of 
equivalent volume, and compares the experimental results of [1987Kam] with those obtained from a 
spherical and needle shaped approximation.
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P_09: Precipitation of Al-Sc AL3SC with Assumption 
of Sphere and Cuboid Morphologies

In this isothermal calculation example, the precipitation of Al3Sc phase from FCC_A1 matrix 
phase in an Al-Sc binary alloy is simulated. To make a comparison, two separate calculations are 
performed, one assuming spherical morphology without elastic strain energy, and the other 
assuming cuboid morphology whose shape is determined by competition between interfacial 
energy and elastic strain energy. The simulation results are compared with experimental data 
collected from Marquis and Seidman [2001Mar] and Novotny and Ardell  [2001Nov]. In addition, 
mean cubic factor and cubic factor distribution are also plotted for cuboid shape to illustrate 
the spherical-cuboidal transition during precipitation. 

For more details about the background theory, see "Precipitation Morphology" on 
page 102.

Project File and Step-By Step Instructions

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_09_Precipitation_Al-Sc_AL3SC_Sphere_Cuboid.tcu

You can also use the step-by-step instructions included in a PDF to follow the video 
or compare to the project file in Thermo-Calc.

Example Settings

To ensure that the settings are done on the correct Precipitation Calculators, the 
Sphere and Cuboid nodes are renamed from Precipitation Calculator to match 
their morphology. The morphology is set in the Precipitate Phase section when 
you click Show Details. See P_08 for an example of this.

System (System Definer)

Database package Demo: Aluminum-based alloys (ALDEMO, MALDEMO)

Tutorial-P_09-Al-Sc-Sphere_Cuboid.pdf
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Elements Al, Sc

Sphere and Cuboid Conditions (Precipitation Calculator)

Composition Al-0.18Sc Mole percent

Matrix phase FCC_A1

Precipitate phase AL3SC

Matrix Phase Data Parameters (Precipitation Calculator)

Elastic properties   
(click Show Details to 
display this setting)

For the Sphere node (renamed from Precipitation Calculator), the default, Disregard 
is kept.

For the Cuboid node (renamed from Precipitation Calculator), choose Cubic. Then 
enter the elastic constants accordingly. Default elastic constants are given based on 
the major element of the alloy system. In this example that is 

 l c11 is 108.2 GPa

 l c12 is 61.3 GPa

 l c44 is 28.5 GPa

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy The default 

Morphology  (click 
Show Details to 
display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default. 

For the Cuboid node (renamed from Precipitation Calculator), Cuboid is selected. 

Transformation strain 
(click Show Details to 
display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default. 

For the Cuboid node (renamed from Precipitation Calculator), Calculate from molar 
volume is selected  to obtain a purely dilatational strain. 

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C
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Simulation time 1.0E9 seconds

Datasets (Experimental File Reader)

Dataset 1 and Dataset 
2

Data sets included with this example and imported to one Experimental File Reader. 
It is used for the Mean Radius plot.

Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our 
website and as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

https://thermocalc.com/support/video-tutorials/precipitation-module-tc-prisma-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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In this example, all nodes are renamed in the Project window, and this matches 
each of the tab names in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.

Figure 43: This shows the predicted evolution of the mean size of precipitates with the experimental 
data from [2001Mar, 2001Nov], comparing the spherical and cuboidal shaped approximations of the 
precipitate morphology. Although there is not significant difference in the results, capturing the 
correct geometry of the precipitate is important in subsequent calculations of precipitate spacing 
used in property calculations.
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Figure 44: These results compare the predicted size distributions after heat treatment considering the 
spherical and cuboidal approximations of the precipitate morphology.

Figure 45: These results compare the predicted evolution of the mean particle radius and mean 
aspect ratio from using the cuboidal approximation of the precipitate morphology. In this case, the 
radius of a sphere of equivalent volume to the cuboidal precipitate is shown.
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Figure 46: These results show the predicted size distribution of the precipitates obtained from the 
cuboidal approximation of the precipitate morphology. Also shown is the calculated size dependent 
cubic factor of the cuboids associated with this dispersion.
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Precipitation of Al-Sc AL3SC with Assumption of 
Sphere and Cuboid Morphologies: Precipitation 
Example P_09 
HELPFUL INFORMATION 

• All users can run this calculation, even those who do not have a license for the Precipitation 
Module (TC-PRISMA).  

• A companion video is available for this example , which can be watched here: 
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ 

• This calculation is based on Precipitation Module example P_09 – Precipitation_Al-
Sc_AL3SC_Sphere_Cuboid, which is included in your installation. 

1. To run the example file, open Thermo-Calc and select Help > Examples Files or click Example 
Files on the My Project Configuration window.  

2. Open the Precipitation Module (TC-PRISMA) folder. Double-click the example file to open it. 
3. In Thermo-Calc at the bottom center of the Configuration window click Perform Tree.  

 

ABOUT THE EXAMPLE  

This example shows you how to calculate the precipitation of Al3Sc phase from FCC_A1 matrix phase 
in an Al-Sc binary alloy using the Precipitation Module (TC-PRISMA).  

Two separate calculations are performed so you can make a comparison of the results, one assuming 
spherical morphology without elastic strain energy, and the other assuming cuboid morphology 
whose shape is determined by competition between interfacial energy and elastic strain energy.  

In addition, mean cubic factor and cubic factor distribution are plotted for cuboid shape to illustrate 
the spherical-cuboidal transition during precipitation.  

https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ


 Precipitation of Al-Sc AL3SC with Assumption  
of Sphere and Cuboid Morphologies 

Precipitation Example P_09 
 

Page 2 of 9 
Version 3 (May 2022) 

 

If you run the example file included in your software, the simulation results are compared with 
experimental data collected from Marquis and Seidman (2001) and Novotny and Ardell (2001). 

SETTING UP THE SYSTEM 

1. Open Thermo-Calc in Graphical Mode.  
2. On the My Project Configuration window under Non-Equilibrium, click Precipitation. 
3. All the nodes for a precipitation calculation are added to the Project window:  

 

4. In the Project window, click the System Definer 1 node.  
5. Set the database Package to Demo: Aluminium-based alloys (ALDEMO, MALDEMO), which 

loads both thermodynamic and kinetic demonstration aluminium databases.  
6. From the Periodic Table, select the elements in the following order.  

Select Al first so that it is the dependant element: 
a. Al (aluminium)  
b.  Sc (scandium).  

7. From the Amount list (to the right of the Periodic Table), select Mole percent. 
8. Enter 0.18 for Sc. This automatically sets Al to 99.82.  
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Our system is now defined. Now set up the precipitation calculations.  

SETTING UP THE PRECIPITATION CALCULATIONS 

There are two precipitation calculations in this example, one assuming spherical morphology without 
elastic strain energy, and the other assuming cuboid morphology whose shape is determined by 
competition between interfacial energy and elastic strain energy. The results are then compared for 
both calculations.  

Setting up the Precipitation Calculation with Spherical Morphology 

1. In the Project window, right-click the Precipitation Calculator 1 node and select Rename. 
Enter Sphere, then press enter or click OK.  

 
2. Notice that the composition set in the System Definer auto-populated on the Precipitation 

Calculator.  
3. Under Matrix Phase from the Phase list it defaults to FCC_A1.  
4. Under Precipitate Phase from the Phase list select AL3SC. 
5. Under Calculation Type, make sure Isothermal is selected, which means that the same 

temperature is maintained throughout the calculation.  
6. Enter  

a. 350 as the Temperature and select Celsius.  
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b. 1.0E9 as the Simulation time and select Seconds. 

 

Our first calculation is set, so next configure the plot.  

Configuring the Plot 

1. In the Project window, right-click Plot Renderer 1 and select Rename. Name the plot Mean 
radius then press enter or click OK. 

2. Under Y-axes change the units to Nanometer (nm). 
3. From the Axis type list select Logarithmic 10.  

 

The plot is now set, but before running the simulation you set up another calculation and link it to 
the same Plot Renderer.  

Setting up the Precipitation Calculation with Cuboid Morphology 

1. In the Project window, right-click the Sphere node and select Clone.  
a. Right-click the Sphere 1 node and select Rename.  
b. Name the node Cuboid and press enter or click OK.  

2. On the Configuration window to the right of Matrix Phase click Show Details.  



 Precipitation of Al-Sc AL3SC with Assumption  
of Sphere and Cuboid Morphologies 

Precipitation Example P_09 
 

Page 5 of 9 
Version 3 (May 2022) 

 

3. From the Elastic Properties list select Cubic. Keep the suggested default values. Click Hide 
details. 

 

4. To the right of Precipitate Phase, click Show details.  
5. From the Morphology list select Cuboid.  
6. From the Transformation strain list select Calculate from molar volume. 

  

The second calculation is now set up, so now link it to the Plot Renderer node.  

Linking the Plot to the Calculation with Cuboid Morphology 

1. In the Project window, right-click the Mean radius node and select Add Predecessor 
>Cuboid.  

2. Notice that in the Configuration window there are two tabs associated with this plot, one for 
Sphere and one for Cuboid. The Sphere settings are already configured, so you just need to 
set up the Cuboid tab.  

 
3. Click the Cuboid tab. 
4. Under Y-axes change the units to Nanometer (nm). 
5. From the Axis type list select Logarithmic 10.  
6. The calculation is now ready to run. Right-click the Mean radius node and select Perform 

Now or click Perform on the Configuration window. 
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INTERPRETING THE RESULTS OF THE PRECIPITATION CALCULATIONS 

  

In this plot, the blue line represents the sphere calculation and the red line represents the cuboid 
calculation. You can see that, in this instance, these are almost identical.  

By ‘radius for non-spherical particles’ it means the radius of equivalent spheres with the same 
volume. 

If you run the example file that is included in your software, the plot also contains an experimental 
file, which you can see closely matches the calculations. 

PLOTTING ADDITIONAL VARIABLES 

Now you use the same calculation to set up additional plots using the many available variables. The 
examples below include two Y-axes each.  

Plotting Mean Radius and Cuboid Factor 

This plot has two Y-axes: Mean radius and Cuboid factor.  

1. Right-click the Cuboid node and add a Plot Renderer.  
2. Right-click the new node and rename it Mean radius and Cuboid factor.  
3. Under Y-axes click the plus sign to add another axis.  
4. Keep Mean radius as the first axis variable but change the units to Nanometer (nm) and set 

the axis type to Logarithmic 10.  
5. Set the second Axis variable to Mean cubic factor.  
6. Click to clear the Automatic scaling check box. In the fields, enter the Limits from 1 to 1.41 

and the step to 0.1.  
7. The plot is now set. Click Perform.  

In this plot, the blue 
line represents the 
sphere calculation 
and the red line 
represents the cuboid 
calculation. You can 
see that, in this 
instance, they are 
almost identical.  
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Interpreting the Results of Mean Radius and Cuboid Factor 

  

The blue line represents the evolution of the average radius of the cubic particles as a function of 
time. Again, for non-spherical precipitates this means the radius of equivalent spheres with the same 
volume.  

The red line shows the average cubic factor as a function of time. A value of one represents a 
spherical shape. A square root of two represents a cubic shape.  

In this plot, the blue line 
represents the evolution 
of the average radius of 
the cubic particles as a 
function of time. The red 
line shows the average 
cubic factor as a function 
of time. 
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The evolution of the shape when the particles grows is determined by competition between 
interfacial energy and elastic strain energy. In general, the shape is close to spherical at small particle 
sizes because the interfacial energy term dominates.  

At large sizes the elastic energy dominates and it is therefore more favourable with a non-spherical 
shape.  You can see that the particles get a more cubic form at later times when they grow to larger 
sizes.  

Plotting Particle Size and Cubic Factor Distribution 

This final plot shows the particle size distribution (PSD) and cubic factor distribution at the end of the 
simulation.  

This plot also has two Y-axes, so you can clone the previous plot. 
1. Right-click the Mean radius and Cuboid factor node and select Clone. 
2. Right-click the new node and rename it PSD and Cuboid factor.  
3. Under the Y-axes 

a. Select Size distribution as the first Axis variable.  
b. Change the Axis type to Linear.  

4. Set the second Y-axis to Cubic factor distribution and enter a Time of 1e9 Seconds.  
5. Keep the Automatic Scaling check box cleared. Enter the Limits from 1 to 1.45 and the step 

to 0.1.  
6. Under Size X-axis, change the unit to Nanometer (nm).  
7. Click Perform at the bottom center of the Configuration window. 
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Interpreting the Results of Particle Size Distribution and Cuboid Factor 

  

The blue curve, which shows the particle size distribution, is close to the regular LSW size distribution 
that is expected for spherical particles.  

The cubic factor distribution shows that the smallest particles are closer to spherical and that the 
larger ones get more and more cubic. 

References 
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In this plot, the blue 
curve shows the 
particle size 
distribution and the 
red line shows the 
cubic factor 
distribution. 
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P_10: Initial Particle Size Distribution of Fe-Cr-C

This example demonstrates the effect of initial particle size distribution (PSD) of the precipitate 
phases on the overall precipitation kinetics. It uses two Precipitation Calculators to simulate 
and compare carbide precipitations from a ferritic BCC_A2 matrix in a Fe-0.1C-12Cr alloy. Three 
carbides, CEMENTITE, M23C7, and M7C3 are included in the calculations simulating a complex 
precipitation sequence with stable and meta-stable precipitate phases. The results show a large 
difference in predicted behaviour, with meta-stable precipitates dissolving earlier as a result of 
the stable precipitates existing in the initial condition.

This example also shows the different ways to create the initial size distribution.

 l Generate 3D PSD from distribution function: CEMENTITE's PSD is approximated from 
an LSW distribution.

 l From File: M23C6's PSD is loaded from a file.

 l Approximate the 3D PSD from experimental data: M7C3's PSD is approximated from 
1D experimental data descriptive of halved linear intercepts. 

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_10_Precipitation_Initial_PSD_FeCrC.tcu

There are also two *.csv files available for you to use as a template for when you are importing 
data from a file. 

 l Input data for M23C6: P_10_Precipitation_Initial_PSD_FeCrC_psd_3D_M23C6.csv

 l Input data for M7C3: P_10_Precipitation_Initial_PSD_FeCrC_psd_1D_M7C3.csv

Preexisting Particle Size Distribution

The Preexisting Particle Size Distribution window shown in Figure 47 is a graphical 
representation of the radius versus corresponding number densities, with fields available to 
enter the initial precipitate composition and volume fraction. An editable table is also provided 
for the particle size distribution.

"Particle Size Distribution (PSD)" on page 36
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Cementite
The amount of Fe and Cr must be defined for Cementite for this alloy. Fe is set to the 
dependent component, and 72 mass percent of Cr is set. The option Generate 3D PSD from 
distribution function is chosen to create the PSD for Cementite. The initial volume fraction of 
0.001 % is assumed. An LSW distribution is selected with a mean radius of 1E-8m.

Figure 47: An LSW distribution with a mean radius of 1E-8m is used.

M23C6
The amount of Fe and Cr must be defined for M23C6 for this alloy. Fe is set to the dependent 
component, and 70 mass percent of Cr is set. The From File option is used to create the PSD. 

The file loaded for M23C6 is available from the Example files → Precipitation 
Module - TC-PRISMA  folder and is named P_10_Precipitation_Initial_PSD_
FeCrC_psd_3D_M23C6.csv.

You can import data from a spreadsheet or text file (.xls, .xlsx, .csv, or .txt formats are 
acceptable). The initial volume fraction of 0.15 % is assumed.
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M7C3
The amount of Fe and Cr must be defined for M7C3 for this alloy. Fe is set to the dependent 
component, and 83 mass percent of Cr is set. The Approximate the 3D PSD from experimental 
data option is used to create the PSD.

In this example, the linear intercept method is used to measure the size distribution of M7C3 
from micrographs descriptive of sectioning the dispersion. A size distribution of halved linear 
intercepts is created and is available as a file you can use as a template. 

The file loaded for M7C3 is available from the Example files → Precipitation 
Module - TC-PRISMA  folder and is named  P_10_Precipitation_Initial_PSD_
FeCrC_psd_1D_M7C3.csv.

The Dimensionality of the exp. data is set to 1D. The experimental data is loaded by importing 
the above named *.csv file. An LSW Distribution is used.  When you click Generate, it calibrates 
the chosen distribution and stereology description to the experimental data. The initial volume 
fraction of 0.15 % is assumed.
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Example Settings

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase
BCC_A2

All other defaults are kept.

Precipitate phases CEMENTITE, M23C6 and M7C3

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Grain boundaries (all calculations): Calculated from the matrix settings with a 
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wetting angle of 90°

Interfacial energy

User-defined function f(r,T) (all calculations):

 l CEMENTITE: 0.167 J/m2

 l M23C6 0.252 J/m2

 l M7C3 0.282 J/m2

Preexisting size 
distribution (click Show 
Details to display this 
setting)

For the Precipitation Calculator including particle size distribution (PSD), and for 
all precipitate phases, this checkbox is selected.

For each precipitate phase (CEMENTITE, M23C6 and M7C3), click Edit Particle 
Size Distribution to make changes to the parameters. A window opens with a 
graphical representation of the radius vs number density.

Input type

 l Generate 3D PSD from distribution function - CEMENTITE uses this 
option in the example

 l From File - M23C6 uses this option in the example

 l Approximate the 3D PSD from experimental data - M7C3 uses this 
option in the example.

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 1053 K

Simulation time 400 000 seconds

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.
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Figure 48: These results show the predicted volume fraction of cementite, M23C6, and M7C3 during 
an isothermal aging with an initial particle size distribution of each precipitate phase. The predicted 
kinetics are sensitive to the initial size, volume fraction, and composition of these precipitates.

Figure 49: The predicted volume fraction of cementite, M23C6, and M7C3 during an isothermal aging 
with no precipitates in solution in the initial condition.
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P_11: Interfacial Energy Function

In some cases, interfacial energy may be a function of temperature and/or particle radius. This 
example uses four Precipitation Calculators at four temperature points in 30 K increments: 673 
K, 703 K, 733 K, and 763 K. It is an isothermal calculation to examine the mean radius of an Al-
0.12Sc system. It uses an FCC_A1 matrix phase and AL3SC precipitate phase with bulk 
nucleation sites and user-defined interfacial energy function. The user defined interfacial 
energy function uses an error function to set a smooth transition of the interfacial energy from 
0.065  J/m2 to 0.085   J/m2 for particle radii below and above 1e-8m and 5e-8m, respectively.

A dataset based on Iwamura and Miura [2004Iwa]  data is compared with the calculated results.

"Interfacial Energy Anisotropy" on page 90

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_11_Interfacial_energy_function.tcu

Example Settings

System (System Definer)

Database package Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Conditions (Precipitation Calculator)

Composition Al-0.12Sc Mole percent

Matrix phase
FCC_A1

All other defaults are kept.
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Precipitate phase

AL3SC

Nucleation sites (all calculations): Bulk (6.025E28 m-3)

Interfacial energy (all calculations): User-defined function f(r,T): 0.075+0.011*erf((r-
3e-8)/1e-8 J/m2)

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal (all calculations)

Temperature Four temperature points in 30 K increments: 673 K, 703 K, 733 K, and 763 K.

Simulation time 1 000 000 seconds (all calculations)

Datasets (Experimental File Reader)

Wamura 2004 
(Dataset 1)

Data set included with this example and imported to one Experimental File Reader. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

When you run (Perform) this example, it takes a few minutes for the calculations 
to complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.

Figure 50: The results of an isothermal calculation to examine the mean radius of an Al-0.12Sc 
system with experimental data from [2004Iwa]. 
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Reference

[2004Iwa] S. Iwamura, Y. Miura, Loss in coherency and coarsening behavior of Al3Sc 
precipitates. Acta Mater. 52, 591–600 (2004).
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P_12: Comparing Growth Rate Models for an Al-Zr 
System

This example compares the Simplified, General, and Advanced growth rate models for an Al-Zr 
system. The resulting plot compares the mean radius of the spheres for each AL3ZR_D023 
precipitate phase calculated for each type of growth rate model. 

All models treat a spherical particle (precipitate) of stoichiometric composition or with 
negligible atomic diffusivity. Local equilibrium at the precipitate-matrix interface is assumed. 

When you use the Advanced model,  the velocity of a moving phase interface and the operating 
tie-line are solved together from flux-balance equations. This model can treat both high 
supersaturation and cross diffusion rigorously. It can also capture the transition between NPLE 
(non-partitioning local equilibrium) and PLE (partitioning local equilibrium) without any ad hoc 
treatment.

The Simplified model is based on the quasi-steady state diffusion approximation, and estimates 
solute partitioning  with matrix composition and nuclei composition instead of time-consuming 
stepwise tie-line calculations. It also neglects cross diffusion for simplicity. 

The General model  can be considered the same theoretical approximation as, but an 
improvement over,  the Simplified model, with cross-diffusion terms taken into account, as well 
as adjustment of Gibbs-Thomson effect and effective diffusivity implemented. A dataset based 
on Knipling et al. [2008Kni]   data is compared with the calculated results.

For more background information,  see the theory described in "Growth" on 
page 83. 

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_12_Precipitation_Al-Zr_GrowthRateModel_comparison.tcu

Example Settings

System (System Definer)

Database Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)
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package

Elements Al, Zr

Conditions (Precipitation Calculator)

Composition Al-0.2Zr Mole percent

Matrix phase
FCC_A1

All other defaults are kept.

Precipitate 
phase

AL3ZR_D023

Click Show Details to select the Growth rate model (Simplified, Advanced and General). 
All other defaults are kept.

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 425 Celsius

Simulation time 400 hours

Datasets (Experimental File Reader)

2008 Knipling Data set included with this example and imported to one Experimental File Reader.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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When you run (Perform) this example, it takes a few minutes for the calculations 
to complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.
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Figure 51: This shows the impact of the available growth rate settings options and compares the 
mean radius measurements of [2008Kni] with results obtained from the simplified, general, and 
advanced growth rate models. The experimental data includes measurements taken from different 
dendrites.

Reference

[2008Kni] K. E. Knipling, D. C. Dunand, D. N. Seidman, Precipitation evolution in Al–Zr and Al–
Zr–Ti alloys during isothermal aging at 375–425 °C. Acta Mater. 56, 114–127 (2008).
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P_13: Paraequilibrium Precipitation of Cementite 
Fe-C-Cr

In this example, the precipitation of cementite during tempering of a Fe-Cr-C steel is simulated 
considering two interface conditions: one is the usual ortho-equilibrium condition; the other is 
the para-equilibrium condition. The simulation results are compared with the experimental 
data from Sakuma et al. [1980Sak]. 

This example demonstrates that the early stage of the cementite precipitation can only be 
accounted for by a simulation applying the para-equilibrium condition, under which the 
precipitation kinetics are controlled by the diffusion of C. The comparison also shows a later 
stage gradual transition from the para-equilibrium condition to the ortho-equilibrium condition, 
and if the tempering time is long enough the diffusion of Cr has a dominating effect on the 
coarsening of cementite. 

For more background information,  see the theory described in "Growth" on 
page 83. 

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_13_Precipitation_Fe-C-Cr_Paraequilibrium_Precipitation_of_
Cementite.tcu

Example Settings

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO, MFEDEMO)

Elements Fe, Cr, C

Conditions (Precipitation Calculator)

Composition Fe-0.95Cr-1.065C Mass percent

Matrix phase
BCC_A2

All other defaults are kept.
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Precipitate phase

CEMENTITE

Click Show Details to select the Growth rate model (Simplified and Para-eq). All other 
defaults are kept.

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 773 Kelvin

Simulation time 20 hours for the paraequilibrium model and 600 hours for the simplified model.

Datasets (Experimental File Reader)

1980 Sakuma Data set included with this example and imported to one Experimental File Reader.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

When you run (Perform) this example, it can take over two hours to complete the 
calculations. 

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.

Figure 52: These results compare the predicted and measured evolution of the mean radius of 
cementite with the experimental data from [1980Sak] to simulation predictions obtained from the 
ortho-equilibrium (OE), and para-equilibrium (PE) approximations of the precipitate composition. The 
precipitate growth kinetics exhibited by cementite can be rationalized by the transition from PE to 
OE.
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Reference

[1980Sak] T. Sakuma, N. Watanabe, T. Nishizawa, The Effect of Alloying Element on the 
Coarsening Behavior of Cementite Particles in Ferrite. Trans. Japan Inst. Met. 21, 159–168 
(1980).
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P_14: Grain Growth and the Zener Pinning Effect

This example demonstrates the simulation of normal grain growth and the pinning effect 
[1948Smi; 1998Man] of precipitated second-phase particles on the grain boundary motion.

To investigate the grain growth and Zener pinning effect, an Fe-0.2C (wt.%) binary alloy, with a 
BCC_A2 matrix phase and CEMENTITE precipitate phase, is simulated and uses the 
demonstration steel databases, FEDEMO and MFEDEMO. These databases are available to all 
users (i.e. you do not need a license for the Precipitation Module (TC-PRISMA)) and contain the 
necessary thermodynamic and kinetic data needed for the calculation.

For more details, see the theory described in "Normal Grain Growth" on page 105 
and "Zener Pinning" on page 107.

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_14_Precipitation_Fe-C-Ferrite-Grain_Growth_with_Zener_
Pinning.tcu

Example Settings

System (System Definer)

Database 
package

Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, C

Conditions (Precipitation Calculator)

Composition Fe-0.2C Mass percent

Matrix phase

BCC_A2

 l Grain boundary energy (J/m2): 0.5
 l Grain boundary mobility: Prefactor(m4/Js): 2 x 10-15

 l Click to Edit grain size distribution. Then Initial grain size distribution: Hillert 
distribution with average radius of 3.2 x 10-6 m
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 l Mobility adjustment: Same for all elements. Prefactor 0.08.

Precipitate 
phase

CEMENTITE

 l Zener pinning parameters:  Cutoff size (m): 8.0 x 10-7

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 722 °C

Simulation time 35 hours

Datasets (Experimental File Reader)

[1975Hel] Data sets included with this example and imported to two Experimental File Readers.

Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our 
website and as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

https://thermocalc.com/support/video-tutorials/precipitation-module-tc-prisma-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.

The calculated equilibrium volume fraction of CEMENTITE at 722 °C (0.02786), using FEDEMO, 
matches that (0.02787) of a Fe-0.2C-0.004S-0.0004O-0.001N-0.001Al (wt.%) multicomponent 
commercial alloy, calculated using the latest version of the TCS Steel and Fe-alloys Database 
(TCFE), an alloy that was studied by Hellman and Hillert [1975Hel]. The mobility adjustment 
assures the precipitation kinetics of CEMENTITE phase in Fe-C system matches that of 
experimental data [1975Hel] of the commercial counterpart (and shown in Figure 53)
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Figure 53: The evolution of the mean radius of cementite comparing the experimental data from 
[1975Hel] with the Precipitation Calculator results.

The grain boundary energy was chosen to be a reasonable value of 0.5 J/m2. There is a large 
discrepancy, in several orders of magnitude, among experimental data regarding the grain 
boundary mobility. In the present calculation, a value of 2x10-15 m4/Js was chosen.

Figure 54: The evolution of the mean grain radius of ferrite comparing the experimental data from 
[1975Hel] with predictions made with and without Zener pinning from an evolving dispersion of 
cementite precipitates.
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P_15: Smooth Transition from Paraequilibrium to 
Ortho-equilibrium

In this example, the precipitation of cementite during tempering of an Fe-Mn-C steel is 
simulated considering three interface conditions:  the usual ortho-equilibrium (OE) condition; 
paraequilibrium (PE) condition; and  a smooth transition from paraequilibrium  to ortho-
equilibrium condition (PE-OE). The simulation results are compared with the experimental data 
from Miyamoto et al. [2007Miy].

The Precipitation Calculator nodes are renamed in the example to match the 
abbreviations for the three interface conditions considered: OE, PE, and PE-OE. 
Also see the video to learn how to create this example.

This example demonstrates that the early stage of the cementite precipitation follows a PE 
condition, under which the precipitation kinetics is controlled by the diffusion of C. At a later 
stage, gradual transition from PE condition to OE condition occurs, and if the tempering time is 
long enough the diffusion of Mn has a dominating effect on the coarsening of cementite. While 
a Simplified model follows the OE condition and a Para-eq model follows PE condition, the PE 
Automatic model enables the smooth transition from PE condition at early stage to OE 
condition at a late stage.

The example uses the demonstration steel databases, FEDEMO and MFEDEMO. These 
databases are available to all users (i.e. you do not need a license for the Precipitation Module 
(TC-PRISMA)) and contain the necessary thermodynamic and kinetic data needed for the 
calculation.

For more details, see PE Automatic Growth Rate Model described in the "Growth" 
on page 83 theory section.

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_15_Precipitation_Fe-C-Mn_PE-OE_Precipitation_of_Cementite.tcu
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Example Settings

System (System Definer)

Database 
package

Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, Mn, C

Conditions (Precipitation Calculator)

Composition Fe-1.96Mn-0.61C mass percent

Matrix phase

BCC_A2

Click Show Details:

 l Grain size: Average radius 1.0E-7m

 l Grain aspect ratio: 100.0

 l Mobility adjustment: Keep the default, Same for all elements, then enter 0.008 
for the Prefactor, and -7e4 J/mol for the Activation energy.

All other defaults are kept.

Precipitate 
phase

CEMENTITE

Click Show Details to select the Growth rate model (Simplified, Para-eq, and PE 
Automatic). All other defaults are kept.

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 923.15 Kelvin

Simulation time 1E6 seconds for Simplified and PE Automatic models, and 5 seconds for Para-eq model

Datasets (Experimental File Reader)

Mean Radius Exp Data set including experimental mean radius of cementite

Mn 
Concentration

Data set including experimental Mn composition in cementite
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Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our 
website and as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

When you run (Perform) this example, it takes a few minutes for the calculations 
to complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.

https://thermocalc.com/support/video-tutorials/precipitation-module-tc-prisma-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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Figure 55: A comparison between the measurements of mean cementite radius from [2007Miy] with 
the simplified (OE), para-eq (PE), and PE Automatic (PE-OE) growth models. The PE-OE model is 
needed to capture the nucleation, growth, and coarsening behavior of cementite.

Figure 56: A comparison of the evolution of the cementite Mn composition during isothermal aging 
at 923.15 K between the experimental data from [2007Miy] with model predictions obtained from 
the simplified (OE) growth model, the para-eq (PE) growth model, and the PE Automatic (PE-OE) 
growth model. The PE-OE model captures the behavior shown in the experimental data, where the 
Mn composition transitions from the initial ferrite composition towards the equilibrium cementite 
composition.
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P_16 Isothermal Coarsening and  a 3D to 2D 
Stereological Conversion  

This example demonstrates the use of the 3D → 2D stereological conversion functionality to 
compare Precipitation Module (TC-PRISMA) predictions with experimental data obtained from 
Scanning Electron Micrographs (SEM). 

The 3D → 2D setting is available on a Plot or Table Renderer that is a successor to 
the Precipitation Calculator, and when certain axis variables are selected for a 
spherical morphology.  

For more background information,  see the theory described in "Stereology" on 
page 110. 

The isothermal coarsening kinetics of γ' precipitates in a Ni-Al-Cr alloy is modeled. The 
experimental data is from [2008Sud], which investigates isothermal coarsening kinetics at a 
temperature of 873 K for up to 264 h. 

It is assumed that there are no precipitates in solution at the beginning of the isothermal heat 
treatment.

Project File Information

 l Folder: Precipitation Module - TC-PRISMA

 l File name: P_16_Precipitation_Ni-Al-Cr_Stereology.tcu

Example Settings

The example also includes an Equilibrium Calculator and Table Renderer to first  
confirm the stability of the precipitate phase for this system (FCC_L12#2), then 
determine particle composition at 1073 K, and this information is used with the 
Precipitation Calculator set up.
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System (System Definer)

Database 
package

Demo: Nickel-based superalloys (NIDEMO and MNIDEMO)

Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition Ni-10l-8.5Cr Mole percent

Matrix Phase

FCC_L12

 l Click Show Details and for the Mobility adjustment enter 0.5 for the 
Prefactor.

 l All other defaults are kept.

Precipitate 
Phase

FCC_L12#2

Click Show Details and adjust the default settings as indicated: 

 l Interfacial energy: Select User-defined and enter 0.01 J/m2. 

Calculation Type  (Precipitation Calculator)

Calculation 
Type

Isothermal

Temperature 1073 Kelvin

Simulation time 300 h

Datasets (Experimental File Reader)

2008 Sudbrack 
et al

Data sets are included with this example and are imported using the Experimental 
File Reader activity. There are 2D size distributions comparing results after a total 
of 16 h aging, 64 h aging, and 264 h of aging, and a comparison of the  
experimental and predicted 2D mean radius versus time. 
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Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access 
in a variety of ways. When in Thermo-Calc, from the menu select Help → Video 
Tutorials, or from the main My Project window, click Video Tutorials. Alternately,  
you can go to the website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for 
Isothermal or Non-isothermal Calculation Types, you can preview the profile and adjust 
settings as needed. When you click a calculator node in the Project window, the 
matching name of the node is on the tab(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for 
the Precipitation Calculator tab in the Visualizations window as there is no 
Thermal Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to 
view the matching name of the node on tab(s) in the Visualizations window, either click 
a Plot Renderer or Table Renderer node in the Project window or click the tabs 
individually in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the 
Visualizations window showing the constant temperature entered for this 
calculation type. The tab names match the node names in the Project window.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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Figure 57: A comparison of the evolution of the mean 2D precipitate radius measurements of 
[2008Sud] with model predictions.

Figure 58: A comparison of the predicted and measured 2D size distribution after 4 h of aging.
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Figure 59: A comparison of the predicted and measured 2D size distribution after 16 h of aging.

Figure 60: A comparison of the predicted and measured 2D size distribution after 64 h of aging.
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Figure 61: A comparison of the predicted and measured 2D size distribution after 264 h of aging.

Reference

[2008Sud] C. K. Sudbrack, T. D. Ziebell, R. D. Noebe, D. N. Seidman, Effects of a tungsten 
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model Ni–Al–Cr superalloy. Acta Mater. 56, 448–463 (2008).
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